HUD Training Academy
and
Multifamily Housing Programs

Multifamily Housing Occupancy Training for Subsidized Multifamily Housing Properties

Distance Learning Training

August 12, 13, 14 & 15, 2003
11:00 A.M. - 5:00 P.M.
Eastern Standard Time
The HUD Training Academy
“Investing in the Power and Potential of HUD Employees”

Course Announcement

Course Code: HX2003-05
Course Title: Multifamily Housing Occupancy Training for Subsidized Multifamily Housing Properties

The Multifamily Housing Occupancy Training is being conducted in conjunction with one of several HUD initiatives under the Rental Housing Integrity Improvement Project (RHIIP). The RHIIP initiative is a coordinated effort among the Offices of Housing, Office of Public and Indian Housing, Office of Policy Development and Research, and the Chief Financial Officer. The Occupancy Training is designed to inform HUD staff and other Contract Administrators of policies and procedures that will assist them in detecting and reducing errors in the amounts of rental assistance payments made to owners.

This course is designed to provide comprehensive guidance on planning and conducting occupancy reviews to detect and reduce errors in the subsidy payments made by HUD. The two (2) steps in reducing errors are: 1) knowledge of and familiarity with the information in Handbook 4350.3 Rev.1, Occupancy Requirements of Subsidized Multifamily Housing Programs and 2) use of the new Rent and Income Determination Quality Control Monitoring Guide to detect and report errors.

Objective

At the end of this course, given the participant workbook, instruction, discussions, and activities, participants will be able to plan, conduct, and close out a monitoring review; detect and report errors found in subsidy payments made by HUD and reduce errors in rent and income determinations.
U.S. Department of Housing and Urban Development
Multifamily Housing Occupancy
For Subsidized Properties Training
August 12 – 15, 2003

AGENDA

Moderator - Peter Giaquinto

Tuesday, August 12, 2003

11:00 – 11:05      Keypad Instructions
11:05 – 11:10      Opening Remarks      Vyllorya Evans
11:10 – 11:20      Welcome          Dr. John C. Weicher
11:20 – 11:30      Tenant’s Perspective   Louise Sanchez
11:30 – 11:55      RHIIP Overview      Ulyses Bridges
11:55 – 12:05      BREAK
12:05 – 12:25      Using the Handbook       Kathleen Piacesi

12:25 – 12:45      Multifamily Subsidized Program Ulyses Bridges
12:45 – 2:00        LUNCH

2:00 – 3:30      Fair Housing Regulations       Estelle Franklin

Jana Erickson

3:30 – 3:45      BREAK

3:45 – 4:45      Program Eligibility
Section 202/811 Eligibility
Requirements
Owner-Adopted Preferences/ Restrictions

Diane Hooten
Gail Williamson

4:45 – 5:00      Wrap up                  Peter Giaquinto
U.S. Department of Housing and Urban Development  
Multifamily Housing Occupancy  
For Subsidized Properties Training  
August 12 – 15, 2003

AGENDA

Wednesday August 13, 2003

11:00 – 11:30  Tenant Selection  Kathleen Piacesi  
Plan Requirements  
Waiting List Management  Diane Hooten

11:30 – 11:50  Application Processing  Ulyses Bridges

11:50 – 12:00  BREAK

12:00 – 12:45  Income & Rent  Diane Hooten

12:45 – 2:00  LUNCH

2:00 – 2:35  Recertification Process  Diane Hooten

2:35 – 2:50  Leases  Ulyses Bridges

2:50 – 3:10  Billing Requirements  Diane Hooten

3:10 – 3:20  BREAK

3:20 – 5:00  Occupancy Handbook  
Wrap Up  Ulyses Bridges, et al

Thursday, August 14, 2003

11:00 – 11:10  Welcome  Stillman D. Knight, Jr.

11:10 – 11:20  Planning for the Review  Kathleen Piacesi

11:20 – 11:45  Preparing for the Review  Diane Hooten

11:45 – 11:55  BREAK
U.S. Department of Housing and Urban Development
Multifamily Housing Occupancy
For Subsidized Properties Training
August 12 – 15, 2003

AGENDA

12:05 – 12:45 Preparing for the Review Continues Diane Hooten
12:45 – 2:00 LUNCH
2:00 – 3:00 Conducting the On-site Review Linda Kornegay

Skit 1 – Verification and Calculation of Income & Rent
Skit 2 – Application Processing
Skit 3 – Review Certification/Recertification Process

3:00 – 3:15 Open Qs&As Linda Kornegay
3:15-3:25 BREAK
3:25 – 5:00 Review of Tenant Files and Introduce Case Study Diane Hooten

Friday, August 15, 2003

11:00 – 12:00 Case Study Discussion Diane Hooten
12:00 – 12:10 BREAK
12:10 – 12:30 Post Review Activities Kathleen Piacesi
12:30 – 12:45 Tracking rent & income Determination Errors Linda Kornegay
12:45 – 2:00 LUNCH
U.S. Department of Housing and Urban Development
Multifamily Housing Occupancy
For Subsidized Properties Training
August 12 – 15, 2003

AGENDA

2:00 – 3:15  Open Q&As on Case Study and Conducting on-site reviews
             Diane Hooten, et. al

3:15 – 3:30  Closeout          Vyllorya Evans

Reminders:

1. Mailbox for Q&As
   occupancy_handbook_comments@hud.gov

2. HUD Handbook 4350.3 REV-1 is available at: HUDCLIPS

3. Rent and Income Determination Quality Control Monitoring
   Guide is available at: HUDCLIPS

4. Mailbox for Tracking is Mf-Qct@hud.gov
Course Outline

I. Introduction

A. RHIIP Overview

B. Policy Changes Overview

1. Estimating medical expenses (4350.3, Paragraph 5-10.D)
2. Recertification timeline lengthened (4350.3, Paragraph 7-7)
3. Amount of increase in income that triggers an interim recertification increased from $40 to $200 (4350.3, Paragraph 7-11)
4. Owners must include unborn children and children who are in the process of being adopted for determining family size for income limits (4350.3, Paragraph 3-6.E. 4 d and e)
5. Additional guidance on house rules (4350.3, Paragraph 6-9)
6. Affirmative Fair Housing Marketing plan must be reviewed and updated (4350.3 Chapter 4, Paragraph 4-12)
7. Additional guidance for defining remaining family member (4350.3, Paragraph 3-15)
8. All adult members of the household must sign the data collected by the owner [59 facsimile] (4350.3, Paragraph 9-5.A.4.b)
9. Tenant selection plans are required (4350.3, Paragraph 4-4)
10. Owner must submit special claims within 180 days after the unit becomes available for occupancy (4350.3, Paragraph 9-14.B.4.a and 9-14.C 4 a)
11. Calculate partial month subsidy by dividing the actual number of days in a month (4350.3, Paragraph 9-12 E)

C. Using Occupancy Handbook 4350.3 REV-1

II. Planning the Monitoring Review

A. Identify Properties for Review

1. Properties with financing subsidies (4350.3, Chapter 1, Paragraph 1-3 A)
2. Properties with direct loans and grants (4350.3, Chapter 1, Paragraph 1-3 B)
3. Properties with rental subsidies (4350.3, Chapter 1, Paragraph 1-3 C)
B. Laws, Regulations and Policies (What you must know to monitor.)

1. Fair housing regulations:
   a. Section 504 versus Fair Housing Act
   b. Fair Housing Act (4350.3, Chapter 2, Paragraph 2-5)
   c. Section 504 of the Rehabilitation Act of 1973 (4350.3, Chapter 2, Paragraph 2-8)
   d. Accessibility Requirements (4350.3, Chapter 2, Section 3, Subsection 1: Overview and General Requirement)
   e. UFAS – accessible units (4350.3, Chapter 2, paragraph 2-26 and Paragraph 2-22 C 4)
   f. Reasonable accommodation (4350.3, Chapter 2, Subsection 4)
   g. Assistance animal (As a Reasonable Accommodation, Chapter 2, Paragraph 2-44, Paragraph 3-28 for Verification and Glossary definition)
   h. Verification for need for accessible unit (4350.3, Chapter 3, Paragraph 3-27 B and Chapter 2, Paragraph 2-31)

2. Project Eligibility Requirements
   a. Program eligibility requirements (Key Requirements 4350.3 Chapter 3, Paragraph 3-5)
   b. Specific eligibility requirements for admission (4350.3, Chapter 3, Paragraph 3-19)
   c. Exceptions and waivers (4350.3, Paragraphs 3-7, 3-8 and 3-19 G)
   d. Owner adopted preferences or restrictions (Title VI D, 4350.3, Chapter 3, Paragraph 3-17)

3. Tenant selection plan and waiting list requirements
   a. Owners must develop Tenant Selection Plans and make the Plan public (4350.3, Chapter 4, Paragraph 4-4 A)
   b. Tenant Selection Plan topics (4350.3, Chapter 4, Paragraph 4-4 C and Figure 4-2)
   c. Placing families with disabled family members (4350.3, Chapter 4, Paragraph 4-17)
   d. Statutory and regulatory preferences (4350.3, Chapter 4, Paragraph 4-6 B)
   e. Owner adopted preferences (4350.3, Chapter 4, Paragraph 4-6 C)
   f. Owners must not implement local residency unless HUD has approved residency preference (4350.3 Chapter 4, Paragraph 4-6 C 1)
   g. Income targeting policies (4350.3 chapter 4, Paragraph 4-5)
h. Applying income targeting requirements (4350.3, Chapter 4, Paragraph 4-25)
   i. Waiting List management
      i. Waiting list required elements (4350.3, chapter 4, Paragraph 4-14B)
      ii. Types of waiting lists (4350.3, Chapter 4, Paragraph 4-18)
      iii. Updating the waiting list (4350.3, Chapter 4, Paragraph 4-18 D and E)
      iv. Assigning Larger Units [Single Person] (4350.3, Chapter 3, Paragraph 3-22 G and Chapter 4, Paragraph 4-15 F)

4. Application processing requirements
   a. Interview procedures (4350.3, Chapter 4, Paragraph 4-24 and Exhibit 4-1)
   b. Screening process (4350.3, Chapter 4, Paragraph 4-7)
      i. Paragraph 4-7 B Key requirements
      ii. Paragraph 4-7 B Drug Abuse and other Criminal Activity
      iii. Paragraph 4-7 D 2 application and screening fees for subsidized cooperatives
      iv. Paragraph 4-8 Prohibited screening
   c. Verification process (4350.3, Paragraphs 3-26 thru 3-29)
      i. Social Security Numbers (Paragraph 3-30 Procedure used for verification)
      ii. Verification of immigration status – Changes to the Systematic Alien Verification of Entitlements (SAVE) System (4350.3 Chapter 3, Paragraph 3-12 H)

5. Income and rent determination
   a. Most common errors (4350.3, Paragraph 5-1 C)
   b. Procedure for determining annual income
      i. Withdrawal of cash or assets from an investment (4350.3 Paragraph 5-6 N)
      ii. Social security income for assisted living/ICF/MR – 4350.3 Paragraph 5-6 M
   c. Procedure for determining adjusted income
      i. Medical expenses (4350.3, Paragraph 5-10 D.6; Exhibit 5-3)
      ii. Childcare – two assisted families (4350.3, Paragraph 5-10 B.4)
   d. Procedure for determining total tenant payment/tenant rent
      i. Determining rent for police officer (4350.3, Paragraph 5-27)
ii. Determining rent in double occupancy group homes (4350.3 Paragraph 5-28 C, D and E)

e. Verification
   i. When third party verification is not available (4350.3, Paragraph 5-13 C)
   ii. Electronic verification (4350.3, Paragraph 5-13 B)
   iii. Social Security and supplemental security income data match (4350.3, Paragraph 5-16)
   iv. Inconsistent information obtained (4350.3, Paragraph 5-18)
   v. Documenting verification (4350.3, Paragraph 5-19)

6. Re-certification requirements

a. Change to re-certification time line (4350.3, Chapter 7, Figure 7-3 and paragraph 7-7)
b. Effective date for changes in assistance payments (4350.3, Chapter 7, paragraph 7-8)
c. Extenuating circumstances (4350.3, Chapter 7, Paragraph 7-8)
d. Penalty for failure to re-certify for PRAC tenants (4350.3, Chapter 7, paragraph 7-7)
e. Interim re-certification is triggered by increase of family income of $200
f. Adult children may not join the household after initial move-in in a 202/8 project except as a live-in aide (4350.3, paragraph 7-4 D)

7. Lease requirements

a. Requirements for briefing tenants (4350.3, Chapter 6, Paragraph 6-27, Briefing with tenants)
b. Lease and attachments (4350.3, Chapter 6, Paragraph 6-5 and Figure 6-3)
   Paragraph 6-5 G. For Section 515/8 or State Agency properties.
   Paragraph 6-5 A 3, for subsidized cooperatives.
   Paragraph 6-5 C 5, for police officers and security personnel
   Paragraph 6-5 D and E for 202 and 811 lease modifications
c. House rules (4350.3, Chapter 6, Paragraph 6-9 B-Key requirements)
   Paragraph 6-9 B 1 e 2, extended absence
   Paragraph 6-9 B 1 f Note, Smoking policy
d. Termination of tenancy for drug abuse and other criminal activity (4350.3, paragraph 8-14)
8. Billing requirements

a. All adult family members must sign the data collected by the owner (59 facsimile). (4350.3, Paragraph 9-5 A 4 b)
b. Record keeping requirements (4350.3, Paragraph 9-7D)
c. Updated Billing Form (4350.3, Appendices 9, 10 and 11)
d. Special claims (4350.3, Paragraph 9-14)
e. Partial month occupancy adjustments (4350.3 Paragraph 9-12 E)
f. Utility reimbursements (4350.3 Paragraph 9-13 B.2)

C. Perform risk analysis

1. Prioritize by projects with greatest risk (Part II, Section C)
2. PBCAs and traditional CAs conduct reviews as defined by their contract (ACC)

D. Prepare for the review

1. Assess the Owner’s policy and procedures for management of occupancy responsibilities. (QC Guide, Part I B)
2. Complete desk review (QC Guide, Part II D)
3. Review TRACS Reports (QC Guide Part II Section D 2)
   a. Perform and analyze Voucher Queries
   b. Perform and analyze Tenant Queries
      ➢ Certification Query
      ➢ Move-In/Move-Out Query
      ➢ Multiple Occupancy Query
      ➢ Project Evaluation Query
      ➢ Verification Query
4. Select tenant files to review (QC Guide Part II, Section E 2)
5. Record tenant file sample to review (QC Guide, Attachment 2)

III. Conducting the Review

A. Determine Reviewer Responsibilities and Key Questions to Use During the Review (QC Guide, Part II, Section E 2)

B. Complete the Tenant File Review (QC Guide, Attachment 7, Instructions, Attachment 6)
C. Summarize Errors Found in Files on the Tenant File Error Summary (QC Guide, Attachment 8)

IV. Closing

A. Prepare Report to Owner (QC Guide, Part II, Section F 2 a, b and c)

B. Conduct Follow-up and Resolution of Errors (QC Guide, Part II, Section F 3)

C. Track Rent and Income Determination Errors (QC Guide, Part III and Attachments 9 and 10.)

Resources:
Handbook 4350.3
Quality Control Monitoring Guide
Case Study for QC Guide
4350.3 Chapter 1, Paragraph 1-7 A (Other Handbooks)
4350.3 Chapter 1 Paragraph 1.7 B (Web sites and Publications)
Multifamily Housing Occupancy Training
For Subsidized Properties

INSTRUCTORS

ULYSES BRIDGES, Director, Housing Assistance Policy Division
Headquarters – Multifamily Housing

JANA ERICKSON, Attorney Advisor, Fair Housing Compliance Division
Headquarters – Office of General Counsel

ESTELLE D. FRANKLIN, Assistant General Counsel, Fair Housing Compliance Division
Headquarters, Office of General Counsel

PETER GIAQUINTO, Project Manager, Housing Assistance Policy Division
Headquarters - Multifamily Housing

ELENA HERL, Program Analyst, Economic Market Analysis Division
Headquarters - Policy Development and Research

DIANE HOOTEN, Project Manager, Asset Management Division
Des Moines, Iowa Program Office – Multifamily Housing

LINDA KORNEGAY, Project Manager, Housing Assistance Contract Administrator
Monitoring Oversight Division
Headquarters – Multifamily Housing

KATHLEEN PIACESI, Housing Project Manager, Grant and Housing Assistance Field Support Division
Headquarters - Multifamily Housing

GAIL WILLIAMSON, Housing Project Manager, Grant Policy and Management Division
Headquarters – Multifamily Housing
Module I – RHIIP INTRODUCTION

GOAL ⇒ Communicate the purpose and strategy of the Rental Housing Integrity and Improvement Project (RHIIP)

OBJECTIVES ⇒ At the end of this module, given the materials and instruction, participants will be able to:

- Define the key components of RHIIP.
- List new policies introduced in the revised Handbook 4350.3 (Occupancy Requirements of Subsidized Multifamily Housing Programs)
- Use tools for locating information in HUD Handbook 4350.3 REV-1

TIME ⏰ 45 minutes

MATERIALS ☑️
- Manual - Using HUD Handbook 4350.3 REV-1 on CD, Crosswalk between Old and Revised Handbook

VISUAL AIDS ☐ Power Points, CD Version of Handbook 4350.3 REV-1
Module I – RHIIP INTRODUCTION

BACKGROUND

The Rental Housing Integrity Improvement Project (RHIIP) is a Secretarial initiative to address the high-risk status and material management control weaknesses associated with HUD’s $18 billion per year rental housing assistance programs.

The Department initiated RHIIP in February 2001 after the release of a study by the Office of Policy Development and Research (PD&R) on Quality Control for Rental Assistance Subsidies Determination.

This study provides national estimates of the extent, severity, sources, and costs of rent errors in HUD’s rental assistance programs.

The study found that substantial errors were being made in the income and rent determinations that set the subsidies HUD pays on behalf of families who receive assistance.

The following Offices are involved in RHIIP activities:

- Office of Housing
- Office of Public and Indian Housing
- Office of Policy Development and Research
- Office of Chief Financial Officer
The Goal of RHIIP is to reduce errors in subsidy payments by:

- 15% in FY 2003
- 30% in FY 2004, and
- 50% by FY 2005.

Multifamily Housing RHIIP Accomplishments

Program Fact sheets for each subsidized program were issued February 2002.

Basic Occupancy Training was provided via satellite in June 2002 presented by HUD staff by satellite broadcast in June 2002. The mortgagor’s ownership status could be . . .

Occupancy classroom training was provided at the Washington Convention Center in May 2003. Revised Handbook 4350.3 was issued June 2003.

RHIIP training August 2003

Revised Handbook 4350.3-REV-1 was issued June 2003.

Rent and Income Determination Quality Control Monitoring Guide was issued August 2003.
OVERVIEW OF POLICY CHANGES

The HUD Handbook 4350.3 REV-1 incorporates program guidance previously issued through regulations, Notices, and memoranda.

The following is a list of policies that are introduced in the revised Handbook and a discussion of how the policy was addressed in the revised Handbook.

1. Estimating Medical expenses

**Old Handbook** – Medical expenses are based on estimated expenses to be paid by the family during the next 12 months following recertification.

**New Handbook** – Owner has three options for estimated medical expenses.

- Use expenses the family anticipates to be paid during the next 12 month after recertification.
- Use unreimbursed medical expenses paid during the past 12 months
- Use past “one-time” nonrecurring medical expenses that have been paid in full.
2. Revises recertification timeline for starting the process of notifying tenants.

   **Old Handbook** - 90 days prior to tenant’s recertification anniversary date

   **New Handbook** - 120 days prior to tenant’s recertification anniversary date

3. Increase in threshold for an interim recertification.

   **Old Handbook** - $40

   **New Handbook** - $200

4. Family Size For Income Limits

   **Old Handbook** - Owners must unborn children and children who are in the process of being adopted for determining size of unit

   **New Handbook** - *Owners must count unborn children and children anticipated to reside in a unit for determining income limits for the family.*
5. House Rules

*Old Handbook* - House rules are established at the discretion of the owner. Provided limited examples of house rules.

*New Handbook* - House rules are established at the discretion of the owner. Provides extensive discussion for establishing house rules and examples of “reasonable” and “unreasonable” house rules.

6. Affirmative Fair Housing Marketing Plan

*Old Handbook* – No requirement for frequency of review and update

*New Handbook* - Requires owners to update AFHMP every 5 years as needed to ensure compliance.

7. Remaining Family Member

*New Handbook* - Provides extensive guidance for defining remaining family member and defines under what circumstances assistance may, or may not, be provided that person.

*Old Handbook* - Defines “surviving family member.” Offers no guidance on when assistance may, or may not, be provided that person.
8. Tenant Information that an owner must submit to the Tenant Rental Assistance Certification System (TRACS) for each tenant (59 Data Requirements)

New Handbook – all adult members of the household must sign the 59 data requirements.

Old Handbook – only head of household must sign the 59 data requirements

9. Tenant Selection Plan

Old Handbook - Recommended

New Handbook - Requires owners to develop, and make public, a tenant selection plan that includes certain required contents.

10. Special Claims for Unpaid Rent and Tenant Damages and Vacancy Losses During Rent-Up

Old Handbook - Owner must submit claim within one year after the unit becomes available for occupancy for special claims for unpaid rent and tenant damages. There was no stated time limit for vacancy losses during rent-up.

New Handbook - Owner must submit claim within 180 days after the unit becomes available for occupancy.
10. Special Claims for Unpaid Rent and Tenant Damages and Vacancy Losses During Rent-Up

**Old Handbook** - Owner must submit claim within one year after the unit becomes available for occupancy for special claims for unpaid rent and tenant damages. There was no stated time limit for vacancy losses during rent-up.

**New Handbook** - Owner must submit claim within 180 days after the unit becomes available for occupancy.

11. Calculating Partial Month Occupancy

**Old Handbook** - Calculate subsidy by dividing by 30 days.

**New Handbook** - Calculate subsidy by dividing the actual number of days in a month.
Using HUD Handbook 4350.3 REV-1

Although new policies were introduced in Handbook 4350.3 REV-1, most information is not new. Guidance from Notices and memoranda that were issued since the Handbook was last updated was incorporated. Tools were added to Handbook 4350.3 REV-1 to assist the user in locating specific information in the Handbook.

The tools are:

The Table of Contents includes more detail.

Key regulations pertaining to information in a chapter or section of a chapter are listed at the beginning of each chapter or section of the chapter.

Key terms that will be used in the chapter are listed at the beginning of each chapter.

The Glossary summarizes and defines all key terms from all chapters in an alphabetical list.

The Index is an alphabetical list of frequently used topics that shows the paragraph and page where the topic is discussed.
The Following Guidance was Incorporated into Handbook 4350.3 REV-1:

Laws and Regulations

Quality Housing and Work Responsibility Act (QHWRA)

Screening and Eviction Rule

Non-Citizen Rule

Other Guidance

Additional information on 202, 202/8, 202 Project Assistance Contracts (PACs) and 202/811 Project Rental Assistance Contracts (PRACs)

Information on Subsidized cooperatives

Current information about Tenant Rental Assistance Certification System (TRACS) certifications and billings

The use of the terms “disability” and “persons with disabilities” is used when appropriate rather than the use of the terms “handicap” and “individual with a handicap” used in prior Handbook and some key regulations.
Explanation of the two definitions of “Persons with Disabilities”

Additional guidance on who is eligible to live in certain properties designed for elderly and/or persons with disabilities. (Title VI D of the Housing and Community Development Act of 1992.)
Module II – PLANNING THE MONITORING REVIEW

GOAL ⇒ Provide information on planning for a monitoring review.

OBJECTIVES ⇒ At the end of this module, given the participant materials and instruction, participants will be able to:

☑ Identify properties for review
☑ Identify key information in HUD Handbook 4350.3 REV-1
☑ Perform a risk analysis
☑ Prepare for a review by:
  ○ Completing a desk review
  ○ Assessing Owner’s policies and procedures
  ○ Reviewing Tenant Rental Assistance Control System (TRACS) reports

TIME ⇒ 8 Hours

MATERIALS

- HUD Handbook 4350.3 REV-1
- Rent and Income Determination Quality Control Monitoring Guide

VISUAL AIDS
- Power Points Slides
- TRACS Reports
Module II – PLANNING THE MONITORING REVIEW

Multifamily Subsidized Programs

Handbook 4350.3 REV-1 describes admission and occupancy requirements for HUD-subsidized multifamily housing programs. The following are programs covered by Handbook 4350.3 REV-1. A monitoring review covering occupancy related issues should be conducted if a project is assisted by any of these programs.

Financing Subsidies - Mortgage Insurance and Mortgage Interest Rate Subsidies

- Section 221(d)(3) Below Market Interest Rate (BMIR) – provides a reduced mortgage interest rate, usually from 1% to 3%, resulting in lower operating costs for the property.

- Section 236 – combines mortgage insurance with interest reduction payments to the mortgagee.

Direct Loans and Capital Advances

- Section 202 Direct Loans – provided direct loans to develop housing for the elderly or disabled.

- Section 202 Capital Advance – provides funds (capital advances), rather than loans, to finance housing for the elderly and persons with disabilities.
Section 811 Capital Advance – provides funds (capital advances), rather than loans, to finance housing for persons

Project Rental Subsidies

- Section 8 – provides payments to Owners on behalf of eligible families.

- Rental Assistance Payments (RAP) – provides payments to Owners on behalf of eligible families.

- Rent Supplement – provides payments to Owners on behalf of eligible families.

- Project Assistance Contract (PAC) – provides payments to Owners of Section 202 properties on behalf of persons with disabilities.

- Project Rental Assistance Contract (PRAC) – provides payments to Owners of Section 202 and Section 811 properties on behalf of the elderly and persons with disabilities.
FAIR HOUSING REGULATIONS

Background

Multifamily Assisted Housing is subject to a range of civil rights laws, which prohibit discrimination, based on race, color, national origin, religion, sex, familial status, disability, and under certain circumstances, age. A Contract Administrator must be aware of how civil rights laws affect properties that they monitor.

Chapter Two of the Handbook provides extensive overview of the scope of all of these laws which include the Fair Housing Act, Title VI of the Civil Rights Act of 1964, Section 504 of the Rehabilitation Act of 1973, the Architectural Barriers Act, the Americans with Disabilities Act of 1990, and the Age Discrimination Act of 1975.

This section focuses more specifically on Section 504 of the Rehabilitation Act, and the Fair Housing Act, especially how these laws apply to disability.

It is important to remember if more than one civil rights law applies to a housing development, as long as they do not conflict, they are all applied. If one law gives greater protections than the other, the greater protections apply as well.

Where Answers to Questions are Located

Handbook Chapter 2, Civil Rights and Nondiscrimination Requirements. Also, other chapters incorporate civil rights concerns as appropriate.

Relevant regulations.
Field and Headquarters FHEO staff.

FHEO web pages.

OGC staff.

What is the Fair Housing Act, and What is Section 504 of the Rehabilitation Act and How do They Differ, Overlap, etc?

The Fair Housing Act - 24 CFR Part 100
The Fair Housing Act prohibits discrimination in most housing and housing-related transactions based upon race, color; religion; sex; disability; national origin, or familial status.

- The Fair Housing Act applies regardless of whether or not the housing receives federal financial assistance.
- For an overview of the Fair Housing Act and its coverage see, Handbook Chapter 2, Section 1, Paragraph 2-5, and Section 2 of the chapter.

The Fair Housing Act prohibits discrimination against persons with disabilities in the same manner that it prohibits discrimination against persons who are members of other protected classes. This includes prohibiting the imposition of terms and conditions on residents and applicants with disabilities that are not imposed on persons without disabilities. For example:

A landlord who has tenants with disabilities who use electric wheelchairs and scooters is prohibited from requiring such individuals to have liability insurance as a condition of using these assistive
The Fair Housing Act has several provisions that specifically address disability discrimination.

- The law requires the provision of reasonable accommodations (changes in policies, practices, and procedures) if necessary to provide persons with disabilities effective use of their housing.
- It contains minimum accessibility requirements for the design and construction of certain covered multifamily housing dwelling units.
- It requires Owners to allow tenants to make and pay for reasonable modifications (structural changes) to their units and the common areas if needed to accommodate their disabilities.

Section 504 - 24 CFR Part 8

- Section 504 of the Rehabilitation Act of 1973 prohibits discrimination based upon disability in all programs or activities operated by recipients of federal financial assistance as well as in all activities conducted by the federal government itself. Section 504 is not a specific housing civil rights law, but it applies to all the housing-related activities operated or funded by HUD.

- Section 504’s disability prohibitions overlap to a large degree with the disability discrimination prohibitions of the Fair Housing Act. However, it differs in that it also imposes broader affirmative obligations on recipients to make their programs as a whole, accessible to persons with disabilities. These obligations include the following:
Module II – PLANNING THE MONITORING REVIEW

- Making and paying for structural modifications to units and/or common areas that are needed by applicants and tenants with disabilities, unless these modifications would change the fundamental nature of the project or result in undue financial and administrative burdens;

- Operating housing that is not segregated based upon disability or type of disability, unless authorized by federal statute or executive order;

- Providing auxiliary aids and services necessary for effective communication with persons with disabilities;
• Developing a transition plan to ensure that structural changes are properly implemented to meet program accessibility requirements;

• Performing a self-evaluation of the recipient’s program and policies to ensure that they do not discriminate based on disability; and,

• Requiring a minimum of five percent of new construction and units undergoing substantial alterations to be fully accessible for persons with mobility impairments in accordance with the Uniform Accessibility Standards (UFAS) and an additional two percent to be accessible for persons with vision and hearing impairments. This requirement is in addition to and separate from the requirement to make structural changes to units or common areas if needed as a reasonable accommodation to a tenant or applicant with a disability.

Major Differences between Section 504 and the Fair Housing Act and How They Apply to Properties Receiving Federal Financial Assistance
Making and paying for structural alterations needed as a reasonable accommodation - If a tenant or applicant with a disability needs a structural change as a reasonable accommodation for that disability, Section 504 requires that the recipient must make and pay for the change, unless it causes a fundamental alteration of the program, or is a financial and administrative burden.

NOTE: This differs from the Fair Housing Act, which expressly places the burden of paying for the structural modification on the tenant. In federally assisted housing, the Section 504 rule prevails over the Fair Housing Act Rule.

For example:

A tenant who uses a wheelchair needs a ramp to get into his unit that has two steps at the entrance. The landlord is obligated to provide and pay for the ramp unless doing so is a financial and administrative burden or a fundamental alteration of his program. If this tenant lived in privately owned and non HUD-subsidized housing, the landlord would have to permit the ramp to be installed but paying for it would be the tenant’s obligation.

- Section 504’s affirmative obligation to make the recipient’s programs usable and accessible to persons with disabilities requires that if a recipient provides transportation to outside activities for residents, he/she must ensure that accessible
transportation is provided as well for residents with mobility impairments.

- Section 504’s affirmative obligations to ensure effective communication with applicants and tenants with disabilities means that if a tenant with a hearing impairment needs a sign language interpreter to adequately understand and participate in community meetings run by the housing provider, in most circumstances, the housing provider would have to provide and pay for the interpreter. This would not normally be required under the Fair Housing Act.

- Affirmative Accessibility Requirements of Section 504 and the Fair Housing Act.
  - Fair Housing Act design and construction requirements (Handbook Subsection 5, Paragraph 2-45, 24 CFR 100.205)

The Fair Housing Act requires that all multifamily buildings containing four or more units designed and constructed for first occupancy after March 13, 1991 meet certain basic accessibility requirements. This requirement applies to all new construction of covered multifamily units, regardless of the presence of federal financial assistance. Covered multifamily units are ground floor units and common areas in non-elevator buildings containing four or more units, and all of the units and common areas in elevator buildings containing four or more units. The Fair Housing requirements do not apply to units in buildings undergoing renovation.

- Section 504 New Construction and Rehabilitation Accessibility Requirements (24 CFR 8.22, 8.23, 8.24)
The Section 504 regulations require that all multifamily projects containing five or more units be constructed so that five percent of the units meet the full accessibility requirements specified in the Uniform Federal Accessibility Standards (UFAS). An additional two percent must be accessible for persons with vision and hearing impairments. Section 504’s affirmative accessibility requirements also apply to units that are undergoing substantial alterations.

**Note:** Units that meet UFAS are significantly more accessible than units that meet the Fair Housing Act design and construction requirements, UFAS units will qualify as Fair Housing Act units, but Fair Housing Act units do not qualify as UFAS units.

**Reasonable Accommodation** (Handbook Subsection 4, Para. 2.37 – 2.42)

- A reasonable accommodation is a change, exception, or adjustment to a program, service, building, dwelling unit, or workplace that will allow a qualified person with a disability to:
  - Participate fully in a program
  - Take advantage of a service
  - Live in a dwelling
  - Perform a job
• The principles of reasonable accommodation are generally the same for Section 504 and the Fair Housing Act, except for the affirmative obligations of the recipient to provide and pay for structural accommodations (modifications), and certain affirmative obligations to accommodate individuals with disabilities to ensure effective communication.

• To show that a requested accommodation may be necessary, there must be an identifiable relationship, or nexus, between the requested accommodation and the individual’s disability. For example, there is a relationship between a need for a ramp and a disability, which requires an individual to use a wheelchair.

• When a family member requires an accessible feature(s), policy modification, or other reasonable accommodation to accommodate a disability, the Owner must provide the requested accommodation unless doing so would result in a fundamental alteration in the nature of the program or an undue financial and administrative burden.

If providing such accommodation(s) would result in an undue financial and administrative burden or fundamental alteration of the program, the Owner must engage in an interactive dialogue with the requester to determine if there is an alternative accommodation that would adequately address the requester’s disability-related needs. If an
alternative accommodation would meet the individual’s needs and is reasonable, the provider must grant it.

- Under both Section 504 and the Fair Housing Act, a tenant or applicant for housing makes a reasonable accommodation request whenever he or she makes it clear to the housing provider that a request is being made for an exception, change, or adjustment to a rule, policy, practice, service, or physical structure because of his or her disability. A request can be made by the person with the disability, a family member, or someone else acting on the individual’s behalf.

- Although a request can be made orally or in writing, it is usually helpful for both the individual with the disability and the housing provider if the request is reduced to writing. If the individual with a disability requires assistance in providing a written reasonable accommodation request, the housing provider should assist the individual with a disability with this request.

- Limits on Obligations to Provide Reasonable Accommodations
Module II – PLANNING THE MONITORING REVIEW

- **Fundamental Alteration**

Owners are not required to take any action that would result in a fundamental alteration in the nature of the program. A fundamental alteration is a change so significant that it alters the essential nature of a provider’s operations. For a detailed explanation of fundamental alteration, see Handbook Exhibit 2-5.

- **Undue Financial and Administrative Burden**

  - The determination of undue financial and administrative burden must be made on a case-by-case basis, involving various factors, such as the cost of the reasonable accommodation, the financial resources of the provider, the benefits the accommodation would provide to the requester, and the availability of alternative accommodations that would adequately meet the requester’s disability-related needs. For examples of undue financial and administrative burden, see Handbook Exhibit 2-6.

  - Owners are not required to make structural changes that would impose an undue financial and administrative burden, even if alternatives to making housing programs or activities readily accessible to and usable by persons with disabilities are not effective.

  - HUD Field Offices will consider a request to use the residual receipts account to pay for alterations under Section 504.
Under HUD requirements, the reserve for replacement account is to be used for replacing existing items. (See Handbook 4350.1, *Multifamily Asset Management and Project Servicing*). If HUD approval is received for using the reserve for replacement account for any other purpose (e.g., Section 504 alterations), then the account must be replenished through property rental income, generally within one year.

- When a request for a reasonable accommodation will result in an undue financial and administrative burden, the Owner must provide all other needed accommodations up to the point at which further accommodations would result in an undue financial and administrative burden.

- Examples of Reasonable Accommodations
  - *Special Issue: Assistance Animals as a Reasonable Accommodation.*
• Assistance animals are not pets. They are animals that work, provide assistance, or perform tasks for the benefit of a person with a disability, or animals that provide emotional support that alleviates one or more identified symptoms or effects of a person’s disability. Assistance animals – often referred to as “service animals,” “assistance animals,” “support animals,” or “therapy animals” – perform many disability-related functions, including, but not limited to guiding individuals who are blind or have low vision, alerting individuals who are deaf or hard of hearing to sounds, providing minimal protection or rescue assistance, pulling a wheelchair, fetching items, alerting persons to impending seizures, or providing emotional support to persons with disabilities who have a disability-related need for such support.

• A housing provider may not refuse to allow a person with a disability to have an assistance animal merely because the animal does not have formal training. Some, but not all, animals that assist persons with disabilities are professionally trained. Other assistance animals are trained by the Owners themselves and, in some cases, no special training is required. The question is whether or not the animal performs the disability-related assistance or provides the disability-related benefit needed by the person with the disability.
A housing provider’s refusal to modify or provide an exception to a "no pets" rule or policy to permit a person with a disability to use and live with an assistance animal would violate Section 504 of the Rehabilitation Act and the Fair Housing Act unless:

- The animal poses a direct threat to the health or safety of others that cannot be reduced or eliminated by a reasonable accommodation;
- The animal would cause substantial physical damage to the property of others;
- The presence of the assistance animal would pose an undue financial and administrative burden to the provider; or,
- The presence of the assistance animal would fundamentally alter the nature of the provider's services.

The fact that a person has a disability does not automatically entitle him or her to an assistance animal. There must be a relationship between the person’s disability and his or her need for the animal.
• A housing provider may not require an applicant or tenant to pay a fee or a security deposit as a condition of allowing the applicant or tenant to keep the assistance animal. However, if the individual’s assistance animal causes damage to the applicant’s unit or the common areas of the dwelling, at that time, the housing provider may charge the individual for the cost of repairing the damage if the provider regularly charges tenants for any damage they cause to the premises.

• Inquiries about Disability in the Occupancy Process
  
  • Owners must not make certain inquiries to determine eligibility.

It is unlawful for an Owner to make inquiries designed to determine whether an applicant may live independently. This is true even if the property serves persons with disabilities. The primary question is whether the applicant can meet the requirements of the lease, not whether the individual can live independently.

• The Fair Housing Act regulations state that it is unlawful for an Owner to inquire:

  ➢ Whether an applicant for a dwelling, a person intending to reside in a dwelling after it becomes available, or anyone associated with an applicant or resident, has a disability; or
Module II – PLANNING THE MONITORING REVIEW

- As to the nature or severity of a disability of such person(s).

- Owners may, however, make the following inquiries, provided these inquiries are made of all applicants, whether or not they are persons with disabilities:
  - Inquiry into an applicant’s ability to meet the tenancy requirements; and,
  - Inquiry to determine if an applicant is a current illegal abuser or addict of a controlled substance.

Some properties may be lawfully restricted to persons with disabilities in general, or to persons that fall within one or more of three categories of disability (i.e., physical disability, developmental disability, chronic mental illness), such as Section 811 Project Rental Assistance Contract (PRAC) properties or Section 202 Direct Loan properties. Owners of such properties may make inquiries of all applicants to determine whether:

- An applicant qualifies for the housing that is available only to persons with disabilities, or to members of the category of disability served by the project; and
An applicant qualifies for a priority available to persons with disabilities or to persons with a particular category of disability.

- Verification of Disability

  - Owners may verify a person’s disability but must adhere to certain verification guidelines.
  
  - The Owner may verify a person’s disability only to the extent necessary to document that applicants:
    
      ➢ Are qualified for the housing for which they are applying;
      
      ➢ Are qualified for deductions used in determining adjusted income;
      
      ➢ Are entitled to any preference they may claim;
      
      ➢ Who have requested a reasonable accommodation have a disability-related need for the requested accommodation or modification; and,
      
      ➢ Need the design features of the unit.

  - Owners may not require applicants to provide access to confidential medical records in order to verify a disability.

- Additional information on verifying eligibility of persons with disabilities can be found in paragraph 3-27 B and in Appendix 15.
PROJECT ELIGIBILITY REQUIREMENTS

Background

A family must meet eligibility requirements before they are permitted to participate in HUD-subsidized multifamily housing programs. A reviewer must know the eligibility requirements of a project before conducting a monitoring review.

All applicants and tenants must meet the following requirements to be eligible for occupancy and housing assistance.

1. Family’s annual income must not exceed program income limits
2. Must disclose social security numbers for all family members at least 6 years old
3. Adult family members must sign an Authorization for Release of information
4. Must be U. S. citizens or eligible non-citizens

Some of HUD’s projects have additional eligibility requirements that an applicant must meet to be eligible for occupancy. Some of these requirements are discussed below.
Section 202/811 Program/Project Eligibility Requirements

The eligibility requirements for the Section 202 Direct Loan Program for Housing for the Elderly or Persons with Disabilities, the Section 202 program of Supportive Housing for the Elderly and the Section 811 program of Supportive Housing for Persons with Disabilities will be described. In addition, eligibility for the various project types under each program will be described and a distinction will be made that being eligible for a particular program does not necessarily mean that a person is eligible for every project developed under the program. Instructions will also be provided on how to submit requests for income/age/population-to-be-served waivers in cases of continuing vacancy problems.

Program Eligibility

Section 202 Direct Loan Program

- Without Rental Assistance
  - Low Income and Exceptions
  - Single persons aged 62 or older; households in which head or spouse is at least 62

- With Section 8
  - Low Income (Housing Assistance P Contract effective prior to 10/1/81)
  - Very Low Income (Housing Assistance Payment (HAP) Contract effective on/after 10/1/81)
  - Extremely Low (at least 40 percent in
any fiscal year)

- Elderly – Definition B of Figure 3-6 of 4350.3 REV-1
  - Disabled – Definitions in Figure 3-6 of 4350.3 REV-1

Definition G – Disabled (Handicapped) Family
Definition H – Person with Disabilities
Definition I – non-elderly Disabled (Handicapped) Family

- Project Assistance Contract (PAC) Funds
  - Low Income
  - Disabled – Definitions in Fig. 3-6 of 4350.3 REV-1

Definition G – Disabled (Handicapped) Family
Definition H – Person with Disabilities (Handicapped Person)

Section 202 Capital Advance with Project Rental Assistance (PRAC)

- Very Low Income
  - Exception – FY95 – Low Income

- Elderly – Definition C in Figure 3-6 of 4350.3 REV-1

- Section 811 Capital Advance with PRAC
- Very Low Income
  - Exception – FY95 – Low Income

- Disabled – Definitions in Figure 3-6 of 4350.3 REV-1
  - Definition F – Disabled Household
  - Definition H – Person with Disabilities
Project Eligibility

Section 202 Without Rental Assistance and Section 202/8 Projects for the Elderly

- Section 202 without Rental Assistance (Prior to 1964)
  Only single people age 62 or older or families in which head or spouse is at least 62


Elderly, and in 10 percent of the units designed for persons with physical disabilities, elderly or non-elderly persons with physical disabilities requiring accessibility features of unit

Section 202 Projects for Non-elderly Persons with Disabilities

- 1964 – 1974: persons with physical disabilities only

- 1974 – 1977: projects for persons with physical disabilities and projects for persons with developmental disabilities

- 1978-1980: projects for persons with physical disabilities, projects for persons with developmental disabilities, projects for persons with chronic mental illness (3 yr demo)
1981: projects for persons with physical disabilities, projects for persons with developmental disabilities

1982-1990: projects for persons with physical disabilities, developmental disabilities, or chronic mental illness, projects for mixed occupancy with Headquarters approval

Section 202 PRAC Projects:
Persons at least 62 yrs old

Section 811 PRAC Projects:
Projects for persons with physical disabilities, developmental disabilities, chronic mental illness (or any combination of the three) who are at least 18 yrs old

Restricted Occupancy – Field Office approval to restrict occupancy to a subcategory of persons with disabilities (e.g., AIDS is a subcategory of physical disability) but cannot deny occupancy to anyone in the overall category

Leasing to Non-Eligible Families

Admitting Over-Income Applicants - Temporary inability to lease all units to income eligible families

1. Must request HUD approval
2. Section 202/8 or Section 202/PAC - Submit waiver request to HUD Field Office

3. Section 202/811 PRAC Units - HUD Field Office must request waiver with recommendation to Headquarters on behalf of Owner

4. Request must provide:
   - Information in Situation 6 of Ex. 3-1
   - Owner’s continued marketing efforts to attract eligible applicants
   - An increased level of occupancy will prevent financial default and foreclosure

5. Approval usually granted for a limited time – initially one year

6. May impose other terms and conditions to protect loan in the case of 202 direct loans

   - In case of HAP or PAC contract, HUD may reduce the number of units covered if:
     1. Owner does not comply with requirements
     2. Inability to lease to eligible families is not temporary
Admitting a Population other than the One Approved to Serve

- In an elderly project, if admitting over-income persons is not solving vacancy problem, may request waiver of age requirement
  - Must document Owner’s continuing marketing efforts
  - Field Office must get Hub approval, except Headquarters approval is required for PRAC projects

- For projects serving persons with disabilities, Owner must apply to Field Office which will forward request and recommendation to Hub for approval
  - Need for original occupancy category no longer exists
  - Owner must be able to serve proposed population
  - Funds available for services with commitment
  - Owner can house new population as current tenants move
  - Must be sufficient subsidized units available in area for current tenants choosing to move
Owner-Adopted Preferences/Restrictions

Title VI-D of the Housing and Community Development Act (commonly referred to as Title VI-D) was enacted on October 28, 1992. Its purpose was to allow Owners of certain federally assisted properties to elect a preference for the elderly or a restriction to the elderly. However, the project must have been originally designed for the elderly and must meet other criteria outlined in Sections 651 and 658 of Title VI-D as outlined below.

Title VI-D of the Housing and Community Development Act of 1992

Section 651 – Owner-Adopted Preferences

- Authorizes Owners of certain “covered Section 8” properties to elect preferences for the elderly
- Definition of “covered Section 8” property
- Applicable Programs
  - Section 8 New Construction
  - Section 8 Substantial Rehabilitation
  - State Housing Agency programs for Section 8 New Construction and Substantial Rehabilitation
  - Rural Housing 515/8
  - Section 8 Property Disposition Set-Aside (only those involving Substantial Rehabilitation)
Criteria for Occupancy Preferences
- Project originally designed for Elderly
- Documentation available
- Must be “covered Section 8” property
- No prior HUD notification necessary

Definitions
- Elderly
- Near-Elderly
- Non-elderly Disabled

In implementing preference, Owner must:
- Notify non-elderly on waiting list
- Update Tenant Selection Plan
- Reserve a percentage of units for disabled who are not elderly or near elderly equal to lesser of
  - Higher of percentage of units occupied by non-elderly disabled on 1/1/92 or 10/28/92, or 10 percent of total units
- If Owner exceeds established number of units for non-elderly disabled and they later become available, Owner may fill them with elderly as long as established set-aside is met

Secondary Preferences
- If insufficient number of elderly families to occupy elderly units, Owner may establish preference for persons with disabilities who are near elderly and have applied.

- If insufficient number of non-elderly persons with disabilities for reserved units, Owner may establish preference for persons with disabilities who are near elderly and have applied.

- If insufficient number of elderly, non-elderly persons with disabilities and near elderly persons with disabilities, must allow all eligible families without regard to preferences under 651.

Section 658 – Owner-Adopted Restriction

Applicable Programs

Section 236

Section 221(d)(3) BMIR

Section 202 (except projects for persons with disabilities and Capital Advance)

If project (or portion of project) was originally designed for occupancy by the elderly and has continuously operated as such, Owner may continue to restrict occupancy to elderly in accordance with rules, standards and agreements governing occupancy at time of development.

- Criteria for Occupancy Restriction
Module II – PLANNING THE MONITORING REVIEW

- Project originally designed to serve elderly
- Documentation must be available
- Project is NOT a “covered Section 8” project
- Project has continuously operated as an elderly project
- Prior HUD notification not necessary

Owners who elect elderly restriction must refer to definition of “elderly” in origination documents to determine correct definition of “elderly” that applies. In some cases, term “elderly” included non-elderly persons with disabilities.

Implementing 658 Restriction

- Notify non-elderly applicants on waiting list
- Update Tenant Selection Plan
- Maintain proof of notification in project files
- Owners may waive restriction due to market conditions and/or to maintain economic soundness of project.
- Must obtain HUD approval for a 3-yr period and to extend
- Owner may revert back to elderly restriction once market conditions improve. Must notify non-elderly
Supporting Documentation

Owners must be able to provide evidence at HUD’s request to demonstrate project originally intended to serve elderly by producing one primary source of information or two secondary sources showing project intended for elderly.

Primary Sources

- Original Application
- Terms of Notice of Funding Availability (NOFA)
- Regulatory Agreement
- Loan Commitment
- Bid Invitation
- Owner’s Management Plan
- Underwriting or Financial Document
- Mortgage Insurance Application

Secondary Sources

- Lease Records
- Services for Elderly
- More than 50 percent of units are efficiencies or 1-bedroom
- Other historical data

Sources in Conflict

If primary source contradicts another primary source or does not provide clear evidence, Owner cannot elect preference or restriction on primary sources alone.
Module II – PLANNING THE MONITORING REVIEW

Totality of Circumstances” – If HUD staff requested to make decision must thoroughly research records and if still uncertain, decision must be that project not designed for elderly.

Provision of 651 and 658 Do Not Apply to the following:

- Section 811 PRAC
- Section 202 PRAC
- Section 202/8 for non-elderly persons with disabilities
- Section 202 PAC
- Section 231 without Section 8
- Family properties (including Section 221(d)(4) with reserved units for the elderly)

References

Title VI-D of the Housing and Community Development Act of 1992

24 CFR 880.612 a

HUD Handbook 4350.3 REV-1
TENANT SELECTION PLAN and WAITING LIST MANAGEMENT

Background

The Owner develops and makes public a Tenant Selection Plan. The policies and procedures for managing the waiting list must be outlined in the Tenant Selection Plan. The reviewer must ensure that the Tenant Selection Plan and the waiting list policies and procedures meet HUD’s requirements.

Tenant Selection Plan

Key Requirements

Owners must develop and make written tenant selection policies and procedures public.

HUD does not approve Tenant Selection Plans except when a residency preference is used at the property.

HUD specifies topics that must be included in Tenant Selection Plans.

Required Topics

The Tenant Selection Plan required topics are listed below. Additional information is added under each topic where important specific information is highlighted. Refer to Handbook 4350.3 REV-1 for a more detailed discussion of each topic.

- Project eligibility requirements
**Definition - Population Served**

If the Owner maintains a separate waiting list for persons with disabilities, the Owner must also place the applicant on the regular waiting list. The decision of whether or not a standard unit will meet the applicant’s needs is left up to the applicant. The tenant may be able to live in a standard unit with reasonable accommodations made to the unit. However, Owners must first offer units with special accessibility features to families that include persons with disabilities requiring such features.

- Income limits
- Procedures for accepting applications and selecting from the waiting list.

Anybody who wishes to be admitted to an assisted property or placed on a property’s waiting list must complete an application.

**Preferences**

Preferences only affect the order of applicants on the waiting list. Preferences do not affect eligibility. Some HUD assisted properties are required by law to have a preference. Others are permitted to establish certain preferences.

**Types of Preferences**

**Statutory Preferences**

Section 221(d)(4) and Section 221(d)(3) - Displaced by government action or disaster.

**Regulatory preferences**
Module II – PLANNING THE MONITORING REVIEW

Section 236 – Displaced by government action or disaster

Section 236 with RAP order of ranking criteria

State and local preferences

Must be consistent with HUD requirements and civil rights requirements.

Owner-adopted preferences

- Residency
- Working family
- Disability
- Victims of domestic violence
- Specific groups of single persons

Income Targeting

Applies to projects assisted under a contract for project-based Section 8 Assistance.

Owner must lease not less than 40% of units that become available in any project fiscal year to extremely low-income families.

- Extremely low-income families are families whose income does not exceed 30% of median income for the area

- HUD does not prescribe a method to achieve compliance with income targeting.

- Compliance requires Owners to count both move-ins and initial certifications.
Module II – PLANNING THE MONITORING REVIEW

Good practice suggests that Owners evaluate admission based on the current waiting list to determine how to comply.

The Owner needs to evaluate the income levels on the waiting list to determine if there are an adequate number of extremely low-income applicants on the waiting list.

After evaluating the income levels he/she may determine that further marketing needs to be completed to reach out to extremely low-income applicants.

The Owner must determine the method he/she wishes to use in order to achieve the income targeting requirement.

When selecting applicants from the waiting list, the Owner may have to skip over higher income applicants to reach the extremely low-income applicant. He/she cannot, however, skip over applicants in order to house an applicant with a higher income.

Applicant Screening Criteria

- Screening Standards used to screen for information on drug-related or criminal activity including registration as a sex offender.
- Occupancy standards
- Unit transfer policies
- Policies to comply with civil rights requirements
Module II – PLANNING THE MONITORING REVIEW

- Policy for opening and closing the waiting list
Waiting List Management

The waiting list should include:

1. Date and time application received
2. Name of head of household
3. Income level of household
4. If the applicant requires an accessible unit
5. If the applicant claims any preference(s)
6. Unit size required

Documenting changes to the waiting lists:

Whenever any type of action is taken regarding an applicant, a notation must be made on the waiting list.

Types of waiting lists:

- Manually recorded
  - Must never be rewritten
  - Maintained so that it cannot be easily altered
  - Must be maintained in a manner so that it can be audited

- Electronic
  - Must use a data backup function to record date and time of new entries/changes
  - Must maintain a printed record that shows the date and time printed
  - Must not allow deletion of entries
  - Must be maintained in a manner so that it can be audited
Module II – PLANNING THE MONITORING REVIEW

Updating the waiting list

The waiting list should be updated annually or semi-annually to ensure applicants are still interested. The Owner must document removal of names from the waiting list with the date and time removed.

If an Owner determines that an applicant was removed in error, the applicant must be reinstated at the original place on the waiting list.

Single persons

Single persons may not occupy units with two or more bedrooms unless:

- Needed as a reasonable accommodation for a person with disabilities
- Verifiable need for elderly person
- Displaced

NOTE: This is statutory and cannot be waived.
THE APPLICATION PROCESS

Anyone who wishes to be admitted to an assisted property must complete an application. The Owner must establish a process for accepting applications and gathering the information needed to establish eligibility, income, deductions and exclusions. This process is one of the most important steps in ensuring that rent and subsidy are correct. The reviewer must ensure that the application process is adequate and that project staff follow the process.

The application process begins with screening of applicants. Screening during the application process is used to help ensure that families admitted to a property will abide by the terms of the lease, pay rent on time, take care of the property and unit, and allow all residents to peacefully enjoy their homes.

Interview Procedures

1. Advise applicant of screening requirements.

2. Confirm and update all information provided on the application.

3. Explain program requirements, verification procedures, and penalties for false information.

4. Obtain family income, assets, family composition and other data needed to verify eligibility.
5. Compute tenant’s rent.

6. Ask all members over 18 to sign consent forms (HUD 9887 and 9887A) for release of information.

7. Require the head, spouse, or co-head and all family members age 6 or older to disclose and document all Social Security Numbers (SSN) [or execute a certification in cases where no SSN has been assigned].

8. Advise the family that HUD will compare the income and family composition information given with information obtained from Federal, state, or local agencies.

9. Advise the family that a final decision on eligibility will be made after all verifications are complete.

10. Provide each applicant with a copy of the appropriate HUD Program Fact Sheet, which describes how tenant’s rent is calculated.

11. Inform applicants of household for the elderly or disabled about the rules for owning pets.

12. Require written certification from head of household, spouse, or co-head as to whether any family member did or did not dispose of any assets for less than fair market value during the two years preceding the effective date of the
certification. The certification form is not prescribed by HUD, but it must include the following:

✓ A list of all assets disposed of for less than fair market value
✓ The dates disposed of and the amount received
✓ The asset’s market value at the time of disposition

NOTE: Owners of BMIR projects need not collect this information for families not needing rental assistance.

Screening Procedures

✓ Used to help ensure that families admitted to a property will abide by the terms of the lease, pay rent on time, take care of the unit/property, and allow residents to peacefully enjoy their homes.

✓ Must be described in the Tenant Selection Plan and consistently applied to all applicants.

✓ Owners must establish written screening criteria to prohibit the admission of certain individuals who have engaged in drug-related criminal behavior, or are subject to a state lifetime sex offender registration program, or are individuals whose abuse or pattern of abuse of alcohol interferes with the health, safety, or right to peaceful enjoyment of the premises by other residents.

✓ Both live-in aides and new additions to the tenant household must be screened for drug abuse and other criminal activity.
Screening Fees in Rental Housing

- Owners may not charge screening fees or fees for credit checks, or require applicants to reimburse them for the cost of screening, including screening for criminal activity.

- Screening costs may be charged as a project operating expense.

Screening Fees in Co-ops

- Cooperatives may require prospective members to pay application fees (approved by the board of directors) if such fees are permissible under state and local laws.

- The application fee must be treated as an earnest money deposit.

- If the applicant is accepted for membership, then the fee is applied to the purchase of the membership.

- If the applicant is rejected, the fee must be refunded to the applicant.

- If the applicant backs out of the purchase transaction, the coop may retain the fee.

Prohibit Screening

- Criteria that could be discriminatory.
- Criteria that require medical evaluation or treatment.
Module II – PLANNING THE MONITORING REVIEW

- Criteria that require meals and other services.
- Criteria that require donation or contribution.
- Criteria that inquire about disabled status.
- Criteria prohibited by state and local laws.

Verification of Family Composition

Verification of family composition is not required. Owners may seek verification of family composition only if the Owner has clear written policy.

Owners may use a policy to verify family composition to determine whether children reside in the household 50% or more of the time. There are various sources from which an Owner may obtain verification of family composition.
**INCOME AND RENT DETERMINATION**

The amount of assistance paid on behalf of the family is calculated using the family’s income less allowable deductions. The reviewer must understand how rent is determined and ensure that the Owner is using the correct method to determine rent and income.

The most commonly made errors when determining a household’s income are:

1. Failure to interview applicants/residents
2. Tenant’s failure to disclose income
3. Owner’s failure to identify exclusions
4. Owner’s failure to obtain 3rd party verifications and accurately calculate income

**Procedures for Determining Annual Income**

The formula for annual income is:

\[ \text{Gross income less exclusions} = \text{Annual Income} \]

24 CFR 5.609; Chapter 5, Section 1 of 4350.3 Rev-1; Exhibits 5-1 and 5-23; and, the Fact Sheets “How Rent is Determined” all address what is and what is not included in annual income.

Since the income inclusions and exclusions are regulatory driven, policies did not change.
The percentage rate of 2% used for calculating imputed income from assets did not change. Handbook 4350.3 Rev-1 provides explanations and examples on what counts as income for some of the more difficult areas of annual income.

Areas where Additional Explanation was provided

- Withdrawal of cash or assets from an investment

The withdrawal of cash or assets from an investment received as periodic payments is counted as income unless the family can document that the amounts withdrawn are reimbursement of amounts they invested.

- Social Security income for assisted living/ICF/MR and ICF/DD facilities

Calculating the income for residents in assisted living facilities is the same as it is for residents of an Intermediate Care Facility for the Mentally Retarded (ICF/MR) or for the Developmentally Disabled (ICF/DD) with one exception. The exception is that the personal benefit allowance is included in the income calculation for the assisting living facilities but excluded for the ICF/MR or ICF/DD facilities.

Procedures for Determining Adjusted Income

The formula for determining adjusted income is:

Annual income less deductions = Adjusted Income
24.CFR 5.611 and Chapter 5, Section 2 of 4350.3 Rev-1 address calculating adjusted income.

**Areas where Additional Explanation was provided**

- Calculating medical expenses:

  Owners may use ongoing expenses not paid from other sources from the preceding 12 months to determine anticipated expenses

  - Two options for counting one-time non-recurring medical expenses:
    - interim re-certification
    - at annual re-certification

- Shared custody of child

  When custody of a child is shared between two assisted families, only one family at a time can claim the dependent deduction and/or child care expenses.

- Authorized Police/Security Personnel

  The rent paid by the authorized police/security person will vary based on whether or not they qualify to receive assistance. When the police/security person’s income is over the income limit for the property, the police/security person is not eligible for assistance and the Owner will set the police/security person’s rent.
Double occupancy group homes

In Section 202/8 group homes designated as double occupancy, each tenant is treated as a separate family.

In Section 811 group homes designated as double occupancy, the tenant pays the calculated total tenant payment.

When there is a change in occupancy, calculating the assistance payment varies depending on the type of project.

Acceptable Methods for Verifying Income

There are three acceptable methods for verifying income:

1. Third party (preferred method)
2. Review of documents
3. Tenant certification

To bring the verification process into this century, instructions are now provided for accepting electronic verifications.

- Faxes
- Email
- Internet

Alternative forms of verifications can be used by the Owner when:

- third-party verification is not received within two weeks.
- the Owner determines and documents third-party verification cannot or will not be received
When Inconsistent Information is obtained through Verifications

An Owner may not take any action to reduce, suspend, deny, or terminate assistance based on inconsistent information received during the verification process until the Owner has independently investigated the information.

RE-CERTIFICATION REQUIREMENTS

Owners must examine and verify income, family composition and other factors affecting continued occupancy at move-in and at least annually for every resident family. The Owner must develop procedures to track and monitor re-certification procedures to ensure that re-certifications are initiated and completed on time. The reviewer must ensure that the Owner’s procedures meet HUD requirements.

Re-certification Timeline

The re-certification timeline has changed. The process now starts 120 days prior to the tenant’s re-certification anniversary date rather than 90 days. Tenants are now required to submit their re-certification information to the Owner by no later than the 10th day of the eleventh month following their last annual re-certification.

If a re-certification is not submitted within 15 months of the previous year’s re-certification anniversary date, HUD or the Contract Administrator will terminate the assistance payment.

Changes in Effective Dates for Assistance Payments when Re-certification is Delayed

In all cases where the tenant reports for re-certification after the 10th day of the 11th month after
the last annual re-certification but before the re-certification anniversary date, all adjustments in assistance payments and the tenant’s rent are made retroactive to the re-certification date.

When the tenant responds after the re-certification anniversary date, the new assistance payment will take effect the first day of the month following the date on which the tenant reported for certification. The tenant must pay the market rent until this date. The tenant may not be evicted for failure to pay the market rent after the tenant reports for the interview and the Owner starts processing the certification.

**Extenuating Circumstances when Tenant Fails to Provide Required Re-certification Information**

When a tenant fails to provide the required re-certification information by the re-certification anniversary date, an Owner must inquire whether extenuating circumstances prevented the tenant from responding prior to the anniversary date.

**Penalty for Tenants who Fail to Recertify and who are Living in Projects with Project Rental Assistance Contracts (PRAC)**

Because 202 PRAC and 811 PRAC projects do not have a market rent, tenants in these projects who fail to recertify are subject to eviction. The tenant will pay the greater of operating rent or 30% of income until eviction procedures are completed.

**Reporting Changes of Income between Annual Certifications**
Tenants are now required to report changes of income when the family’s income cumulatively increases by $200 or more per month.

**Adult Children in Section 202/8 Projects**

When a change in family composition is reported in Section 202/8 projects, there is a restriction on occupancy by adult children. Adult children are not eligible to move into a unit after initial occupancy unless they are performing the functions of and qualify as a live-in aide.

**LEASE REQUIREMENTS**

The lease is a legally binding contract between the Owner and the tenant. The lease identifies program requirements that Owners and tenants must adhere to while participating in the program. The reviewer must understand lease requirements to ensure that the Owner is fulfilling HUD requirements.

Owners must use one of the model leases provided in the Handbook 4350.3 when renting to subsidized tenants. The model leases are found at Appendix 4-A through Appendix 4-D.

The Owner should brief applicants on lease requirements and should explain the following:

- Resident’s rights
- House rules
- Conditions for terminating assistance and tenancy
- Security deposits
- Annual and interim re-certification
- Term of lease
- Tenant rent
A thorough discussion of topics for briefing tenants is found at Exhibit 6-6 in Handbook 4350.3.

**Forms of Model Leases**

- Subsidized Programs:
- Section 8 programs
- Section 221(d)(3)
- Section 236
- Section 202/8 or Section 202 PACs
- Section 202 PRAC
- Section 811 PRAC

In the following circumstances, additional lease requirements must be executed:

1. Reduced rent to police/security personnel
2. 202/811 lease modifications to allow unit entry for health and safety concerns
3. State Agency financed properties
4. Rural Housing financed properties

**House Rules**

House rules are guidelines and provide structure for treating tenants equitable. House rules are developed at the discretion of the Owner; and are not approved by HUD.

House rules identify allowable and prohibited activities in housing units and common areas and must be HUD compliant and reasonable. The House rules may provide the Owner’s policies regarding, among other things, extended absences from the unit and smoking in the common areas.
Termination of Tenancy for Drug Abuse and Other Criminal Activity

- Authority to terminate is in the lease and must be in accordance with state and local laws.
- Provide tenant with written notice of termination which includes:
  - Date assistance will terminate
  - Reason(s) for terminating assistance
  - The amount of rent tenant will be required to pay
  - Notification that if tenant fails to pay the increased rent, Owner may terminate tenancy
- Eviction standards must be consistently applied
BILLING REQUIREMENTS

The reviewer must understand the requirements for transmitting subsidy related data to the Tenant Rental Assistance Certification System (TRACS). These data include tenant data, requests for payment of housing assistance, utility reimbursements and special claims. The reviewer must also understand the requirements for billing records and reporting.

Signature Requirements for Tenant Data Collected by the Owner (59 Data Requirements Facsimile)

The 59 data requirements facsimile must be signed by:

- The Owner
- Head, spouse, co-head and all other adult family members

Record-keeping Requirements

The Owner must keep:

- Signed 59 data requirement facsimiles for tenants from move-in to move-out and for a minimum of 3 years after move-out.
- Signed paper copy of subsidy billing for at least 5 years.

Updated Billing Forms
Module II – PLANNING THE MONITORING REVIEW

Minor changes are being made to the billing forms. After approval by OMB, these forms will be released. Until the forms are released, Owners are to complete the forms per the instructions in the old Handbook 4350.3.

Special Claims

Claims for unpaid rent and damages and for vacancy after rent-up must be submitted to either HUD or the contract administrator for approval within 180 days from the date the vacated unit is available for occupancy.

The Special Claims Guide will be forthcoming with additional requirements relating to special claims processing.

Payments for Partial Month Occupancy

- Units vacated and re-occupied on the same day, Owner may request assistance for:
  - Former tenant – through last full day of occupancy
  - New tenant – beginning with the move-in day

- Calculating partial month occupancy
  - Divide the monthly assistance by the actual number of days in the month
  - Round the result to the nearest $.01
  - Multiply the result by the actual number of days the tenant lived in the unit

Utility Reimbursements
 Owners must provide the utility reimbursement to the tenant within 5 business days of receipt of the assistance from HUD.

With the consent of the tenant, the Owner may pay the utility reimbursement directly to the utility provider.

**RISK ANALYSIS**

The risk to subsidy funds must be considered when scheduling monitoring reviews.

HUD staff must perform a risk analysis of occupancy related issues for all projects and contracts in the Office portfolio to prioritize on-site quality control monitoring reviews.

PBCAs and non-PBCAs should use risk analysis as a tool when preparing for the annual on-site review.

Monitoring based on risk does not mean that only participants with a potential for great risk are selected for review.

Table 1, Risk Factors for Determining Selection for Reviews, in the Rent and Income Determination Quality Control Monitoring Guide, lists indicators of risk to subsidy funds.
Module II – PLANNING THE MONITORING REVIEW

PREPARE for the REVIEW

The reviewer must gather all resources available in his or her office and analyze this information to prepare for the review. This analysis will help the reviewer to pinpoint problems that may exist at the property and save time when the reviewer is on-site.

Assessing the Owner’s Management of Occupancy Responsibilities

A Contract Administrator must understand the Owner’s policy and procedures for handling occupancy functions to conduct a review.

Functional Areas to Assess

- Skill of staff
- Training of staff
- Internal quality controls
- Policies and procedures used for occupancy functions.
- Owner’s job aids
- Computer software used
- Other unique approaches used for occupancy functions

Written policies and procedures can be reviewed either in the Contract Administrator’s office prior to the review or at the property during the review.

If written policies and procedures are not available, the Contract Administrator should interview the staff that perform the function to gain a complete understanding of the policies and procedures.
Knowledge of the Owner’s policies and procedures will help the Contract Administrator detect errors and their underlying cause.

**Conducting the Desk Review**

Prior to the on-site review, the reviewer will need to research information available in the office files or through systems programs such as TRACS, Real Estate Management System (REMS) or HUDCLIPS to gain knowledge about the project they are going to review. This information will assist them in determining the regulations that apply to the property and in identifying potential problems at the property.

**Desk Review Resources**

- Management policies
- Prior Management Reviews
- Annual Financial Statements
- Physical Inspection Reports
- Tenant complaints
- FHEO complaints
- REMS Problem Statement Screen
- Regulations that apply to type of project being reviewed
- TRACS reports
Other, for example:

- income limits
- rents

**Using the TRACS Query Reports**

TRACS Query Reports can be accessed through the secure systems using the appropriate H- or M-ID and password.

Website for HUD staff:  
http://hudapps.hud.gov/ssmaster/index.cfm

Website for Performance Based Contract Administrators (PBCAs):  
http://www.hud.gov/offices/hsg/mfh/trx/trxsum.cfm

At this time, non-performance based Contract Administrators cannot access the queries.

A chart listing the various TRACS query reports and who has access to them is located in Attachment 3, TRACS Query Reports.

Instruction manuals for accessing and using the TRACS reports can also be found on the above websites.

For HUD staff:  
“TRACS Intranet Applications User Guide for HUD Staff”
Module II – PLANNING THE MONITORING REVIEW

For Contract Administrators and Owners:
“Industry User Guide for TRACS Internet Applications”

By reviewing the TRACS reports, the reviewer may determine the need to pre-select some of the tenant files to be reviewed. The reports may also reveal deficiencies in Owner policies and practices or a need for training of on-site staff.

Voucher Queries

- TRACS Voucher List

This report provides a listing of the vouchers submitted for the past 24 months.

Reports B and C listed below are accessed through the TRACS Voucher List.

- TRACS Voucher Detail

Information in this report provides a breakdown of the types of assistance being requested, e.g., regular assistance, adjustments, or special claims.

- TRACS Voucher Discrepancies

This report lists discrepancies found during the electronic review of the voucher.

Tenant Queries

- TRACS Certification List

This report provides a listing of current and future certifications that have been submitted to TRACS.
Module II – PLANNING THE MONITORING REVIEW

Certifications over 15 months old will not be included on this report.

- TRACS Certification History List

  This report is accessed through the TRACS Certification List. This report provides a listing of all available certifications for a particular household.

- TRACS Certification Member List

  This report is accessed through the TRACS Certification History List. This report provides a listing of all household members for a particular household and their relationship to the household.

- TRACS Certification Discrepancy List

  This report is accessed through the TRACS Certification Report. This report lists the discrepancies found during the electronic review of the tenant certification.

- TRACS Move-In/Move-Out Report

  This report provides a listing of the move-in/move-out activity for a specified period of time.

- TRACS Multiple Occupancy Report

  The reviewer will be able to determine from this report if more than one household is occupying a unit or if a resident is residing in more than one assisted unit.
TRACS Verification Report

This report provides a listing of current certifications, bedroom size, household members, income limits and unit rents.

Tenant File Sample Selection

Minimum File Sample Worksheet

<table>
<thead>
<tr>
<th>Number of Units</th>
<th>Minimum File Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 or fewer</td>
<td>5 files plus 1 for each 10 units over 50</td>
</tr>
<tr>
<td>101-600</td>
<td>10 files plus 1 for each 50 units over 100</td>
</tr>
<tr>
<td>601-2000</td>
<td>20 files plus 1 for each 100 units over 700</td>
</tr>
<tr>
<td>Over 2000</td>
<td>34 files plus 1 for each 200 units over 2200</td>
</tr>
</tbody>
</table>

Based on the analysis from the desk review, the reviewer will need to make the decision of how the file sample will be determined.

1. Select files prior to the on-site review.

2. Select files the day of the on-site review.

3. Select files using a combination of 1 and 2 above.
Module II – PLANNING THE MONITORING REVIEW

While conducting the review, the reviewer may find that specific issues arise where a focused review of targeted families would be useful, e.g., non-citizen immigrants, expenses related to disability, etc. The file sample should cover as many varied occupancy related issues and situations as possible. In these instances, the reviewer can either adjust the tenant file sample, or add additional files to the sample. The reviewer needs to remember that there is no maximum number of files to be sampled and reviewed.

Types of Household Characteristics to Consider when Selecting the File Sample

- New admissions
- Re-examinations
- Elderly households
- Disabled households
- Families with dependents
- Households with live-in aids
- Households with large amounts of assets
- Households with child care deductions
- Households with medical expenses
- Zero income households
- Households paying minimum rent
- Households for each bedroom size
- Households receiving utility reimbursements
- Households for each type of subsidy available at the project

Once the tenant file sample is selected, the reviewer should record the files to be reviewed on the Tenant File Sample, Attachment 2, of the Rent and Income Determination Quality Control Monitoring Guide.
Goal: To provide information on conducting a monitoring review.

Objectives: At the end of this module, given the participant materials and instruction, participants will be able to:

- Conduct an onsite monitoring review by reviewing:
  - the Tenant Selection Plan
  - vacancy and turnover procedures
  - procedures for leases and deposits
  - application processing
  - certification/re-certification process
  - tenant files and records

Assess Findings

Time: 3 hour

Materials:
- Manual-Rent and Income Determination Quality Control Monitoring Guide-Case Study

Visual Aids: Skits
Module III – Conducting the Monitoring Review

REVIEWER RESPONSIBILITIES

The monitoring review is completed by using the Leasing and Occupancy portion of the Form HUD-9834, Management Review Questionnaire. The areas that should be monitored during the review include:

- Applicant intake procedures
- Waiting list management
- Tenant selection
- Verification and calculation of income and rent
- Certification and re-certification activities and
- Tenant file review

Because of the types of errors that are most common, emphasis is placed on the application processing, applicant interviews and the need for adequately trained staff. The owner needs to develop policies and procedures for interviewing applicants and for processing applications. Both are important for obtaining the information needed to determine eligibility and the correct rent. In addition to providing continuing training for senior staff, the Owner needs to have procedures in place to ensure that new staff is adequately trained in conducting interviews and on HUD rules and regulations for eligibility, certification/re-certification, calculating income and determining rent.

The reviewer needs to ensure that the Owner has adequate procedures in place to properly interview and process applicants and tenants and that adequate time is spent on the interview and rent determination processes. The reviewer will interview project staff on their knowledge of all aspects of application processing.
and rent determination and determine if staff members are applying the processes consistently.

**Tenant File Review**

**Reviewing the Tenant Files**

Tenant file records are the source documentation for income and rent determinations. The tenant file review is the principal information gathering activity of the on-site monitoring review. In order to complete a comprehensive review of the tenant files, the reviewer must be knowledgeable of the occupancy requirements discussed in the occupancy handbook 4350.3 REV-1. The reviewer must be able to determine if the tenant is eligible to receive rental assistance, if the assistance being paid on the tenant’s behalf is correct, and, if the owner has complied with HUD regulations and requirements.
The documents required to be included in the tenant file are outlined in Attachment 5, Required Tenant File Documentation, in the Rent and Income Determination Quality Control Monitoring Guide. In addition to the files containing the required documentation, the files should be organized. Files where the documents are not organized, e.g., 59 data facsimile and supporting verifications scattered throughout the file are not only hard to audit but usually contribute to rent and income errors.

The Sample Tenant File Review Worksheet, Attachment 7 to the Rent and Income Determination Quality Control Monitoring Guide, should be completed for each tenant file reviewed. The instructions to assist the reviewer in completing the portions of the worksheet related to income and rent errors are included in Instructions for Completing the Sample Tenant File Review Worksheet, Attachment 6.

Once the review has been completed, any errors should be recorded on the Tenant Error Summary, Attachment 8. Once the errors are corrected they will then be recorded on the Quality Control Tracking Log, Attachment 10.

Elements of the Tenant File Review where Rent and Income Errors Occur

- Identifying family members versus household members
Module III – Conducting the Monitoring Review

- Assigning appropriate unit size
- Determining eligibility
- Processing verifications
- Processing certifications/re-certifications
- Determining rent
- Billing for assistance

Questions to be Considered by the Reviewer while Conducting the Review

- Do the files include all of the required documentation for determining eligibility, income and rent?

- Do the files contain the required verification forms for all income, asset, expenses and deductions?

- Do the files show that the owner/agent consistently uses some lesser form of documentation that may reflect a systemic weakness in the verification process?

- Is documentation of similar information consistent from one tenant file to another?

- Is there a pattern of errors in the eligibility, rent or income determinations?

- Are materials in the file organized to provide an accurate and chronological history of events?
MULTIFAMILY OCCUPANCY for SUBSIDIZED PROPERTIES

Case Study

Preparing for and Completing the Case Study

It has already been determined that James and Anna Martin are eligible to live at Pine Ridge Apartments. Using the income information provided in the case study, complete the income and rent portion of the Sample Tenant File Worksheet.

To assist you, the following items are provided:

- Information relating to the household of James and Anna Martin
- Handbook references for verifying and determining income and calculating rent
- Verification forms
- Sample Tenant File Worksheet
- Income and rent worksheet.

After completion of the income and rent determination, determine whether or not there were rent and income errors and the causes for the errors.

Be prepared to discuss the errors found, reasons errors occurred and resolution of the errors.
GOAL
To provide information on closing out a monitoring review.

OBJECTIVES
At the end of this module, given the participant materials and instruction, participants will be able to:

☑ Discuss monitoring review follow-up activities
☑ Discuss error-tracking procedures
☑ Discuss writing up monitoring review findings and errors

TIME
45 minutes

MATERIALS
Rent and Income Determination Quality Control Monitoring Guide

VISUAL AIDS
Power Point
A written report that details the reviewer’s conclusions must be provided to the Owner following a monitoring review. These conclusions regarding the quality of the Owner’s calculations and determinations of annual income and rent and the corrective actions necessary to resolve errors and findings are important in meeting HUD’s goal to reduce errors.

**Post Review Activities**

Findings, causes corrective actions, errors and other conclusions must be clear and well documented.

Tools provided in the Rent and Income Determination Quality Control Monitoring Guide that may be used to document errors are:

- Attachment 7 – Tenant File Review Worksheet.
- Attachment 8 – Tenant File error summary.

Document of errors by dollar amount is important because the dollar amount of errors must be tracked.

**Monitoring Review Report**

Report must include:

- Errors and findings
Findings are different from errors. An error may be specific to a particular file. A pattern of errors may become a finding if a systemic problem is indicated. A finding occurs when a HUD requirement is not met.

A finding must include:

- What is being done incorrectly
- What HUD requirement was not met
  - Statute
  - Regulation
  - Contract
  - Handbook
  - Notice or memorandum
- The corrective action
- Date when the corrective action must be completed

Follow-up Activities

- Track owner response
- Track owner progress in resolving discrepancies
Module IV – CLOSING

- Analyze owner difficulties in addressing issues
- Take actions to ensure that all corrective actions are completed
- Technical assistance
- Sanctions

Tracking is required for all corrections of errors resulting in an over or underpayment of rent or subsidy found during monitoring reviews conducted by HUD staff, Project Based Contract Administrators (PBCAs) or non-PBCA or traditional Contract Administrators.

Importance of Tracking the Errors:
- To achieve HUD's goal to reduce rental subsidy errors
- To ensure collections are made

Rent and income determination monitoring will occur during these reviews:
- Regularly scheduled management and occupancy reviews (MORs)
- Monthly Housing Assistance Voucher (HAP) voucher
- Annual compliance review of PBCAs
- On-site review of non-PBCAs
HUD will provide an electronic excel spreadsheet to be used as a tracking log for PBCAs, non-PBCAs and HUD Field Offices to facilitate the reporting of rent and income determination errors by dollar amount.

The tracking log will enable the Department to collect data on the type of errors found and the dollar amounts of the corrected errors.

Information is documented on the tracking log once the Contract Administrator confirms that the error has been corrected.

Errors that have not yet been corrected on the Housing Assistance Payment (HAP) voucher must not be recorded on the log.

**Repayment Plans**

For each review conducted, the log must specify the required corrective action for repayment of any dollar overpayment or underpayment. A copy of the repayment schedule, if applicable, should be available to assure the amount of the funding error is reimbursed in a timely manner.

**NOTE:** Only the amounts received during a given month should be shown on the tracking log, not the total amount that is being repaid.

Contract Administrators must maintain documentation that supports:
The timeframes for submitting the tracking log are the same for all Contract Administrators and are outlined in Exhibit 3 of the Rent and Income Determination Quality Control Monitoring Guide.

The Hubs are to submit the completed tracking logs each month to a mailbox that was established in Headquarters.

The mailbox address is Mf-Qct@hud.gov.
Case Study: Elderly Household

James Martin and his wife, Anna, live in Unit 203 at Pine Ridge Apartments. They moved in on 2/10/2003. Pine Ridge is 100% Section 8, Project Number 085-EH089, Contract Number WA04-T822-008. The contract rent for this unit is $450.00. The Martin household’s income was under the very low-income limit at move-in, therefore, they were income eligible for the project.

The 59 data requirements sheet in the file shows the following household information:

<table>
<thead>
<tr>
<th>Member Number</th>
<th>Household Member</th>
<th>Relationship</th>
<th>Social Security Number</th>
<th>Date of Birth</th>
<th>Age</th>
<th>Special Status Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>James J. Martin</td>
<td>H</td>
<td>333333333</td>
<td>4/10/1926</td>
<td>76</td>
<td>E</td>
</tr>
<tr>
<td>2</td>
<td>Anna M. Martin</td>
<td>S</td>
<td>444444444</td>
<td>6/4/1927</td>
<td>75</td>
<td>E</td>
</tr>
</tbody>
</table>

Information in file:

- Social security numbers have been verified with their social security cards
- Citizenship has been declared
- Screening has been completed for:
  - Criminal and drug
  - Sex offender
  - Previous landlord
  - Credit
- HUD-9887/9887-A consent forms were signed by both James and Anna at move-in
- Age was verified with copies of birth certificates
- HUD model lease for 202 in file—not signed by management or Anna

Verifications received relating to income and rent: (see verification documents)
State of New Jersey
Certificate and Record of Birth

This certifies that a certificate of birth has been filed with the proper offices in Camden County
bearing the name of James John Martin
Who was born on April 10, 1926 at Mercy Hospital.

Name of Professional Attendant
Donald Griffith, M.D.
Name of Father
Benjamin Martin
Mother's Maiden Name
LouAnne Netzer

State of New Jersey
Certificate and Record of Birth

This certifies that a certificate of birth has been filed with the proper offices in Bergen County
bearing the name of Anna Maria Paterno
Who was born on June 4, 1927 at St. Agnes Hospital.

Name of Professional Attendant
Lewis Bayfield, M.D.
Name of Father
Mario Paterno
Mother's Maiden Name
Sofia Rosa Marchetti
TO: Social Security Administration  
202 Government Way  
Anytown, US 12345  

FROM: Pine Ridge Apartments  
19 Poplar Road  
Anytown, US 12345  

RE: Martin James J.  
Name  
833-33-3333  
Social Security Number  

Thank you for your prompt response. All information is confidential.  
Please contact Mary Smith  
at (888) 555-5555 if you have any questions.  

PERMISSION FOR RELEASE OF INFORMATION  

You do not have to sign this form if either the requesting organization of the organization supplying the information is left blank.  
Release: I hereby authorize the release of the requested information. Information obtained under this consent is limited to information that is no older than 12 months. There are circumstances, which would require the owner to verify information that is up to 5 years old, which would be authorized by me on a separate consent, attached to a copy of this consent.  

Mary Smith  
Signature  
2-3-03  
Date  

THIS SECTION TO BE COMPLETED BY SS / SSI ADMINISTRATOR(S)  

COMPLETE AS APPLICABLE  

Gross monthly payment  
$725.00  

Deductions for Medicare premiums  
$54.50  

Net amount of payment  
$670.50  

TYPE OF BENEFITS – check all that apply  

Social Security  
☑ Retirement  
☐ Disability  
☐ Widow(er)  
☐ Child(ren)  

Supplemental Security Income  
☐ Old Age  
☐ Disability  
☐ Blind  
☐ Other  

The above amount became effective on 6/29/02.  

We are unable at this time to verify information requested:  
☐ Claim still pending  
☐ No record based on identifying information  
☐ Other - see reverse side of form  

SOCIAL SECURITY ADMINISTRATION  

Signature  
Mary Velazquez  
Print your name  
Marcia Velazquez  
Title  
Administrator  
Address  
202 Government Way  
Anytown, US 12345  

Date  
2-7-03  
Tel. #  

PENALTIES FOR MISUSING THIS CONSENT:  
Title 18, Section 1001 of the U.S. Code states that a person is guilty of a felony for knowingly and willingly making false or fraudulent statements to any department of the United States Government. HUD, the PHA and any owner (or any employee of HUD the PHA or the owner) may be subject to penalties for unauthorized disclosures or improper uses of information collected based on the consent form. Use of the information collected based on this verification form is restricted to the purposes cited above. Any person who knowingly or willfully requests, obtains or discloses any information under false pretenses, using an agent or participant may be subject to a misdemeanor and fined no more than $5,000. Any person or participant affected by negligent disclosure of information may bring civil action for damages, and seek other relief, as may be appropriate, against the officer or employee of HUD, the PHA or the owner responsible for the unauthorized disclosure or improper use.
TO: Social Security Administration
202 Government Way
Anytown, US 12345

FROM: Pine Ridge Apartments
79 Poplar Road
Anytown, US 1345

RE: Martin Anna M.

Name
441-44-444
Social Security Number

Thank you for your prompt response. All information is confidential.
Please contact Mary Smith
at (555) 555-5555 if you have any questions.

PERMISSION FOR RELEASE OF INFORMATION

You do not have to sign this form if either the requesting organization of the organization supplying the information is left blank.
Release: I hereby authorize the release of the requested information. Information obtained under this consent is limited to information that is no older than 12 months. There are circumstances, which would require the owner to verify information that is up to 5 years old, which would be authorized by me on a separate consent, attached to a copy of this consent.

Mary Smith
Signature
2/3/03
Date

THIS SECTION TO BE COMPLETED BY SS / SSI ADMINISTRATOR(S)

COMPLETE AS APPLICABLE

Gross monthly payment
$ 410.00

Deductions for Medicare premiums
$ 55.50

Net amount of payment
$ 354.50

TYPE OF BENEFITS – check all that apply

Social Security

- Retirement
- Disability
- Widow(er)
- Child(ren)

Supplemental Security Income

- Old Age
- Disability
- Blind
- Other

The above amount became effective on 6-29-02.

We are unable at this time to verify information requested:

☐ Claim still pending  ☐ No record based on identifying information  ☐ Other – see reverse side of form

SOCIAL SECURITY ADMINISTRATION

Signature
Marcia Velazquez
Date
2-7-03
Title
Administrator
Tel. #

Address
202 Government Way
Anytown, US 12345

PENALTIES FOR MISUSING THIS CONSENT:
Title 18, Section 1001 of the U.S. Code states that a person is guilty of a felony for knowingly and willingly making false or fraudulent statements to any department of the United States Government. HUD, the PHA and any owner (or any employee of HUD the PHA or the owner) may be subject to penalties for unauthorized disclosures or improper uses of information collected based on the consent form. Use of the information collected based on this verification form is restricted to the purposes cited above. Any person who knowingly or willfully requests, obtains or discloses any information under false pretenses concerning an applicant or participant may be subject to a misdemeanor and fined not more than $5,000. Any applicant or participant affected by negligent disclosure of information may bring civil action for damages, and seek other relief, as may be appropriate, against the officer or employee of HUD, the PHA or the owner responsible for the unauthorized disclosure or improper use.
TO: ABC Company  
281 Commerce Drive  
Anytown, US 12345

FROM: Pine Ridge Apartments  
19 Poplar Road  
Anytown, US 12345

RE: Martin James J.  
Name  
383-33-3333  
Social Security Number

Thank you for your prompt response. All information is confidential.  
Please contact Mary Smith at (555) 555-5555 if you have any questions.

PERMISSION FOR RELEASE OF INFORMATION

You do not have to sign this form if either the requesting organization of the organization supplying the information is left blank.  
Release: I hereby authorize the release of the requested information. Information obtained under this consent is limited to information that is no older than 12 months. There are circumstances, which would require the owner to verify information that is up to 2 years old, which would be authorized by me on a separate consent, attached to a copy of this consent.

Mary Smith  
Signature  
2/3/03  
Date

THIS SECTION TO BE COMPLETED BY PENSION / ANNUITY ADMINISTRATOR(S)

Type of Pension and Cash value: ABC Company Pension  
$ 15,000

Is this person receiving regular payments?  
☐ No  
☒ Yes

Current Gross Income:  
$ 250.00  
Week  
or  
Month

Medical Deductions:  
$  
Week  
or  
Month

Date of Initial Award  
Effective Date of Current Amount

Total Gross Pension Income expected for next 12 months: $ 3000.00

Pension / Annuity Administrator(s)  
Signature  
Steven Sullivan  
Date  
2/10/03  
Tel. #  

Print your name  
Steven Sullivan  
Title  
Administrator, ABC Co. Pension  
Address  
281 Commerce Drive  
Anytown, US 12345

PENALTIES FOR MISUSING THIS CONSENT:
Title 18, Section 1001 of the U.S. Code states that a person is guilty of a felony for knowingly and willingly making false or fraudulent statements to any department of the United States Government. HUD, the PHA and any owner (or any employee of HUD the PHA or the owner) may be subject to penalties for unauthorized disclosures or improper uses of information collected based on the consent form. Use of the information collected based on this verification form is restricted to the purposes cited above. Any person who knowingly or willfully requests, obtains or discloses any information under false pretenses concerning an applicant or participant may be subject to a misdemeanor and fined not more than $5,000. Any applicant or participant affected by negligent disclosure of information may bring civil action for damages, and seek other relief, as may be appropriate, against the officer or employee of HUD, the PHA or the owner responsible for the unauthorized disclosure or improper use.
TO: First National Bank  
123 Main Street  
Anytown, US 12345

FROM: Pine Ridge Apartments  
79 Poplar Road  
Anytown, US 12345

RE: Martin James J. and Anna M.  
Name  
333-33-3333 / 444-44-4444  
Social Security Number

Thank you for your prompt response. All information is confidential.

Please contact Mary Smith  
at (555) 555-5555 if you have any questions.

PERMISSION FOR RELEASE OF INFORMATION

You do not have to sign this form if either the requesting organization of the organization supplying the information is left blank.
Release: I hereby authorize the release of the requested information. Information obtained under this consent is limited to information that is no older than 12 months. There are circumstances, which would require the owner to verify information that is up to 5 years old, which would be authorized by me on a separate consent, attached to a copy of this consent.

Mary Smith  
Signature  
2/3/03  
Date

THIS SECTION TO BE COMPLETED BY FINANCIAL INSTITUTION

<table>
<thead>
<tr>
<th>SAVINGS ACCOUNT</th>
<th>SAVINGS ACCOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acct #</td>
<td>Acct #</td>
</tr>
<tr>
<td>Current Balance</td>
<td>Current Balance</td>
</tr>
<tr>
<td>Current % Rate</td>
<td>Current % Rate</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHECKING ACCOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Balance for the Past Six Months</td>
</tr>
<tr>
<td>Rate of Interest</td>
</tr>
<tr>
<td>Current Balance</td>
</tr>
</tbody>
</table>

Please list other asset accounts below (Certificates of Deposit, Money Market Funds, Trust, IRA’s, etc.)

<table>
<thead>
<tr>
<th>Account</th>
<th>Balance</th>
<th>Type of Account</th>
<th>Rate of Interest</th>
<th>Cash Value*</th>
</tr>
</thead>
<tbody>
<tr>
<td>4455646677</td>
<td>$6,000.00</td>
<td>CD</td>
<td>3.5%</td>
<td>$2-month penalty for early withdrawal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

NOTE: CASH VALUE IS THE CURRENT VALUE MINUS PENALTIES FOR EARLY WITHDRAWAL.

Signature  
John Jones

Print your name  
First National Bank

Bank Name  
123 Main Street  
Anytown, US 12345

Address  
Title  
Manager

Date  
2/10/03

TEL. #

PENALTIES FOR MISUSING THIS CONSENT:
Title 18, Section 1001 of the U.S. Code states that a person is guilty of a felony for knowingly and willingly making false or fraudulent statements to any department of the United States Government. HUD, the PHA and any owner (or any employee of HUD the PHA or the owner) may be subject to penalties for unauthorized disclosures or improper uses of information collected based on the consent form. Use of the information collected on this verification form is restricted to the purposes cited above. Any person who knowingly or willfully requests, obtains or discloses any information under false pretenses concerning an applicant or participant may be subject to a misdemeanor and fined not more than $5,000. Any applicant or participant affected by negligent disclosure of information may bring civil action for damages, and seek other relief, as may be appropriate, against the officer or employee of HUD, the PHA or the owner responsible for the unauthorized disclosure or improper use.
TO: Aztown Property
78 Main Street
Aztown, US 12345

FROM: Pine Ridge Apartments
19 Popular Road
Aztown, US 12345

RE: Martin James J. and Anna M.
Name
333-333-3333 / 444-44-4444
Social Security Number

Thank you for your prompt response. All information is confidential.

Please contact Mary Smith at (555) 555-5555 if you have any questions.

PERMISSION FOR RELEASE OF INFORMATION

You do not have to sign this form if either the requesting organization of the organization supplying the information is left blank.

Release: I hereby authorize the release of the requested information. Information obtained under this consent is limited to information that is no older than 12 months. There are circumstances, which would require the owner to verify information that is up to 5 years old, which would be authorized by me on a separate consent, attached to a copy of this consent.

Mary Smith
Signature
2/3/03
Date

Description of Property: (acreage, type of structures, etc.)

Townhouse

Address or location (street address or legal description):

456 Fairfield Drive
Aztown, US 12345

THIS SECTION TO BE COMPLETED BY AUTHORIZED OFFICIAL

Market Value $30,000.00

Total Assessed Value $________

If this property were sold, please estimate expenses below:

Broker Fee $________
Legal Fees $________
Settlement Costs $6,800.00
Other (Specify) $________
Balance on Loan $0
Cash Value $________

Signature
Eunice Ellers
Date 2/14/03

Print your name
Eunice Ellers
Tel. #

Title
Clerk

Company Name
Aztown Property

Address
78 Main Street
Aztown, US 12345

PENALTIES FOR MISUSING THIS CONSENT:
Title 18, Section 1001 of the U.S. Code states that a person is guilty of a felony for knowingly and willingly making false or fraudulent statements to any department of the United States Government. HUD, the PHA and any owner (or any employee of HUD the PHA or the owner) may be subject to penalties for unauthorized disclosures or improper uses of information collected based on the consent form. Use of the information collected based on this verification form is restricted to the purposes cited above. Any person who knowingly or willfully requests, obtains or discloses any information under false pretenses concerning an applicant or participant may be subject to a misdemeanor and fined not more than $5,000. Any applicant or participant affected by negligent disclosure of information may bring civil action for damages, and seek other relief, as may be appropriate, against the officer or employee of HUD, the PHA or the owner responsible for the unauthorized disclosure or improper use.
Medical Expense Verification

TO: 8700A Julian Wastrom  
515 Bush Lane  
Liberty, US 44556

FROM: Pine Ridge Apartments  
79 Popular Road  
Anytown, US 12345

RE: Martin James J. and Ann A.
Name
333-33-3333/444-44-4444
Social Security Number

Thank you for your prompt response. All information is confidential.
Please contact Mary Smith  
at (555) 555-5555 if you have any questions.

PERMISSION FOR RELEASE OF INFORMATION

You do not have to sign this form if either the requesting organization of the organization supplying the information is left blank.
Release: I hereby authorize the release of the requested information. Information obtained under this consent is limited to information that is no older than 12 months. There are circumstances, which would require the owner to verify information that is up to 5 years old, which would be authorized by me on a separate consent, attached to a copy of this consent.

Mary Smith  
Signature
2-03-03  
Date

THIS SECTION TO BE COMPLETED BY ADMINISTRATIVE OFFICE

Medical expenses for the above named person (consider only those expenses not covered by health insurance) are estimated to be $500.00 for the upcoming 12 months.

Does the amount shown above include prescription drugs?  
☐ Yes  ☑ No

Does the above named person owe you an outstanding balance?  
☐ Yes  ☑ No

If yes, what is the current balance $____________________

Has a payment schedule been arranged?  
☐ Yes  ☑ No

If yes, what is the amount paid monthly $____________________

Signature  
Ann Lewis

Print your name  
Ann Lewis

Title  
Address
515 Bush Lane  
Liberty, US 44556

Date  
2-8-03  
Tel. #

PENALTIES FOR MISUSING THIS CONSENT:
Title 18, Section 1001 of the U.S. Code states that a person is guilty of a felony for knowingly and willingly making false or fraudulent statements to any department of the United States Government. HUD, the PHA and any owner (or any employee of HUD the PHA or the owner) may be subject to penalties for unauthorized disclosures or improper uses of information collected based on the consent form. Use of the information collected based on this verification form is restricted to the purposes cited above. Any person who knowingly or willfully requests, obtains or discloses any information under false pretenses concerning an applicant or participant may be subject to a misdemeanor and fined not more than $5,000. Any applicant or participant affected by negligent disclosure of information may bring civil action for damages, and seek other relief as may be appropriate, against the officer or employee of HUD, the PHA or the owner responsible for the unauthorized disclosure or improper use.
TO: Target Pharmacy  
495 Washington Blvd.  
Yorba, CA 92878  

FROM: Pine Ridge Apartments  
79 Poplar Road  
Anytown, CA 12345

RE: Martin James J. and Ann M.  
Name  
333-33-3333/444-44-444  
Social Security Number

Thank you for your prompt response: All information is confidential.  
Please contact Mary Smith  
at (555) 555-5555 if you have any questions.

PERMISSION FOR RELEASE OF INFORMATION

You do not have to sign this form if either the requesting organization or the organization supplying the information is left blank.  
Release: I hereby authorize the release of the requested information. Information obtained under this consent is limited to information that is no older than 12 months. There are circumstances, which would require the owner to verify information that is up to 5 years old, which would be authorized by me on a separate consent, attached to a copy of this consent.

Mary Smith  
Signature  
2-3-03  
Date

THIS SECTION TO BE COMPLETED BY PHARMACY

The anticipated amount* to be paid by the above named person in the upcoming 12 months, not covered by medical insurance is:

$_________ per month  or  $1,200.00 per year

*A copy of the pharmacy’s computerized print-out may be attached to this form to assist with the projection of the above individual’s anticipated cost of prescription drug expenses.

Signature  
Print your name  
Title  
Address

Date  
Tel. #  
2/9/03

PENALTIES FOR MISUSING THIS CONSENT:

Title 18, Section 1001 of the U.S. Code states that a person is guilty of a felony for knowingly and willingly making false or fraudulent statements to any department of the United States Government. HUD, the PHA and any owner or any employee of HUD the PHA or the owner) may be subject to penalties for unauthorized disclosures or improper uses of information collected based on the consent form. Use of the information collected based on this verification form is restricted to the purposes cited above. Any person who knowingly or willfully requests, obtains or discloses any information under false pretenses concerning an applicant or participant may be subject to a misdemeanor and fined not more than $5,000. Any applicant or participant affected by negligent disclosure of information may bring civil action for damages, and seek other relief, as may be appropriate, against the officer or employee of HUD, the PHA or the owner responsible for the unauthorized disclosure or improper use.
## Target Pharmacy Prescription Report

Search for: Martin, James  
Martin, Anna

<table>
<thead>
<tr>
<th>Prescription</th>
<th>#</th>
<th>Presc by</th>
<th>Presc Date</th>
<th>Date filled</th>
<th>Refills Remaining</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vioxx 12.5 mg</td>
<td>123AB45</td>
<td>Wastron</td>
<td>10/02/01</td>
<td>01/06/02</td>
<td>8</td>
<td>87.50</td>
</tr>
<tr>
<td>Vioxx 12.5 mg</td>
<td>123AB45</td>
<td>Wastron</td>
<td>10/02/01</td>
<td>02/04/02</td>
<td>7</td>
<td>87.50</td>
</tr>
<tr>
<td>Cipro 20 mg</td>
<td>678CD90</td>
<td>Wastron</td>
<td>02/27/02</td>
<td>02/27/02</td>
<td>0</td>
<td>109.50</td>
</tr>
<tr>
<td>Vioxx 12.5 mg</td>
<td>123AB45</td>
<td>Wastron</td>
<td>10/02/01</td>
<td>03/05/02</td>
<td>6</td>
<td>87.50</td>
</tr>
<tr>
<td>Vioxx 12.5 mg</td>
<td>123AB45</td>
<td>Wastron</td>
<td>10/02/01</td>
<td>04/04/02</td>
<td>5</td>
<td>87.50</td>
</tr>
<tr>
<td>Skelaxin 15 mg</td>
<td>901EF23</td>
<td>Wastron</td>
<td>04/15/02</td>
<td>04/15/02</td>
<td>0</td>
<td>40.50</td>
</tr>
<tr>
<td>Vioxx 12.5 mg</td>
<td>123AB45</td>
<td>Wastron</td>
<td>10/02/01</td>
<td>05/05/02</td>
<td>4</td>
<td>87.50</td>
</tr>
<tr>
<td>Vioxx 12.5 mg</td>
<td>123AB45</td>
<td>Wastron</td>
<td>10/02/01</td>
<td>06/02/02</td>
<td>3</td>
<td>87.50</td>
</tr>
<tr>
<td>Vioxx 12.5 mg</td>
<td>123AB45</td>
<td>Wastron</td>
<td>10/02/01</td>
<td>07/06/02</td>
<td>2</td>
<td>87.50</td>
</tr>
<tr>
<td>Vioxx 12.5 mg</td>
<td>123AB45</td>
<td>Wastron</td>
<td>10/02/01</td>
<td>08/04/02</td>
<td>1</td>
<td>87.50</td>
</tr>
<tr>
<td>Vioxx 12.5 mg</td>
<td>123AB45</td>
<td>Wastron</td>
<td>10/02/01</td>
<td>09/05/02</td>
<td>0</td>
<td>87.50</td>
</tr>
<tr>
<td>Vioxx 12.5 mg</td>
<td>234GH56</td>
<td>Wastron</td>
<td>10/04/02</td>
<td>10/04/02</td>
<td>11</td>
<td>87.50</td>
</tr>
<tr>
<td>Vioxx 12.5 mg</td>
<td>234GH56</td>
<td>Wastron</td>
<td>10/04/02</td>
<td>11/05/02</td>
<td>10</td>
<td>87.50</td>
</tr>
<tr>
<td>Vioxx 12.5 mg</td>
<td>234GH56</td>
<td>Wastron</td>
<td>10/04/02</td>
<td>12/06/02</td>
<td>9</td>
<td>87.50</td>
</tr>
</tbody>
</table>

Total Cost: $1200.00
Computer Generated Facsimile HUD-50059
Owner’s Certification of Compliance with HUD’s Tenant/Eligibility Rent

01 Effective Date: 02/10/03  02 Date tenant moved into project 02/10/03
03 Project Name: Pineridge Apartments  04 Proj # 085-EH089  Contract # WA04-T822-008

6a Action Processed: MI  6b. Action Processed
7 Type of Subsidy: 1  8 NA
9a Race of Head of HH: 2  9b Ethnicity of HH: 2
10. Prev. Hsg Code:
11 Displacement Code: 4  12 Preference Code:

13. Mem
01 Martin  James J  HH  M 04/10/1926 76 E
02 Martin  Anna M  S  F 06/04/1927 75 E

20. SSN/Alien Elig Registration No. Code 22. Place of Birth 23 Occupation
01 333-33-3333 EC Retired 24a. No. of fam Members 2
02 444-44-4444 EC Retired 24b. No. of foster children/live-in 0

26a. Type of Asset 26b C/I 26c. Cash Value 26d. Actual Income HUD passbook rate 27. Imputed income
Checking account  C $ 652 $ 10.00
Real Estate  C $23,200 $ 0
Savings  C $ 5,210 $104.00
CD  C $ 6,000 $210.00

TOTALS $35,062 $324.00 2% $ 701.00

01 $8,046 $8,046
01 $3,000 $3,000
02 $4,266 $4,266

28f. Totals $15,312 $15,312

40a. Total Med. Exp: $ 2,200 52. Utility reimbursement:
40b. Allow for med. Exp: $ 1,720 53. Assistance Payment: $113
41. Elderly/Dis HH Allow: $ 800 54. % Adj. Income charged: 30
42. Total Allowances $ 2,520 55. N/A

43. ADJUSTED INCOME: $13,493
44. CONTRACT RENT: $ 450
45. UTILITY ALLOWANCE: $ 450

46. GROSS RENT: $ 450

James J. Martin  Feb. 10, 2003
Head of Household
Anna M. Martin  2/10/03
Spouse/Co-Head
Mary Smith  02/10/03
Owner/Agent

Case Study August 2003
CASE STUDY

To assist in the completion of the case study, the following handbook 4350.3 REV-1, “Occupancy Requirements of Subsidized Multifamily Housing Programs” references are provided.

Verification requirements:
1. Verification requirements – Paragraph 5-12
2. Acceptable verification methods – Paragraph 5-13
3. Effective terms of verifications – Paragraph 5-17 B

Income:
1. Definition of annual income – Paragraph 5-4

Assets:
1. What are assets – Paragraph 5-7 A
2. Determining income from assets – Paragraph 5-7 B
3. Determining cash value of assets – Paragraph 5-7 C
4. Calculate income from assets when total is $5,000 or less – Paragraph 5-7E
5. Calculate income from assets when total exceeds $5,000 - Paragraph 5-7 F
6. Assets disposed of for less than fair market value – Paragraph 5-7 G.6

Deductions:
1. Deductions permitted for families in which the head, spouse or co-head is elderly or disabled – Paragraph 5-9 B.2
2. Elderly/disabled deducted – Paragraph 5-10 E
3. Medical deduction – Paragraph 5-10 D

Calculating rent:
1. Total Tenant Payment rent formulas – Figure 5-6
Sample Tenant File Review Worksheet

**Instructions:** Review the appropriate number of tenant files and complete this worksheet for each file reviewed. Indicate the initial move-in date in the appropriate box and, if applicable, indicate the current recertification year. Indicate each document available in the tenant file by marking the appropriate corresponding box (Yes, No, or N/A).

<table>
<thead>
<tr>
<th>Date: 4/20/03</th>
<th>Reviewed by: Daisy Smith</th>
</tr>
</thead>
</table>

**Type of Review:**
- Applicant Rejection
- Tenant Move-In **X**
- Tenant Move-Out
- Certification/Recertification

**If Certification/Recertification, indicate certification type:**
- Certification type: Initial **X**
- Annual
- Interim
- N/A

**Project Name:** Pine Ridge Apartments

**Project No.:** 085-EH089

**Contract No.:** WA04-T822-008

**Type of Housing:**
- Elderly **X**
- Family
- Disabled

**Type of Subsidy:**
- Section 8 **X**
- PRAC
- Section 236
- PAC
- 221(d)(3) BMIR
- Rental Supplement

**Family Name:** Martin, James and Anna

**Unit Number:** 203

**Bedroom Size:**
- 0 Bedrooms
- 1 Bedroom **X**
- 2 Bedrooms
- 3 Bedrooms
- 4 Bedrooms
- 5 or more Bedrooms

**Effective date of certification(s) reviewed:**

### A. HOUSEHOLD INFORMATION

<table>
<thead>
<tr>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Application complete and stamped by owner for date and time received?</td>
<td><strong>X</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Household members identified correctly? (head, spouse, dependent, live-in aide)</td>
<td><strong>X</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Unit size appropriate for household?</td>
<td><strong>X</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Was household income eligible at move-in?</td>
<td><strong>X</strong></td>
<td></td>
<td>Over income</td>
</tr>
<tr>
<td>5. If household was not income eligible at move-in, was an exception granted?</td>
<td></td>
<td></td>
<td><strong>X</strong></td>
</tr>
<tr>
<td>6. Resident Rights and Responsibilities acknowledgement?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. Ethnicity and racial data certification?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. HUD-9887/9887-A Consent forms signed by head, spouse, co-head regardless of age and family members at least 18 years of age?</td>
<td><strong>X</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9. Lead-based paint acknowledgement, if applicable?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Have the following items been properly verified and documented?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>10. Social Security numbers for all family members or certification if no SSN?</td>
<td><strong>X</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11. Declaration of citizenship or eligible immigrant status?</td>
<td><strong>X</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12. Criminal and drug screening; sex offender registration?</td>
<td><strong>X</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13. Other screening as disclosed in tenant selection plan?</td>
<td><strong>X</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14. Disability, if applicable?</td>
<td></td>
<td></td>
<td><strong>X</strong></td>
</tr>
<tr>
<td>15. Student status, if applicable?</td>
<td></td>
<td></td>
<td><strong>X</strong></td>
</tr>
<tr>
<td>16. Age, if applicable?</td>
<td><strong>X</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### B. LEASE

<table>
<thead>
<tr>
<th>Question</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Correct HUD model lease used?</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Original lease and subsequent leases or addendums signed by</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>management, head, spouse, co-head, and all other adult members of</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>the household?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Are applicable attachments attached to the lease, (e.g., house</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>rules, pet rules, unit inspection report)?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. If security deposit is required, was it correct?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If required, enter amount here:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. If pet deposit is required, was it correct?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If required, enter amount here:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. If pet deposit was paid in installments was payment in accordance</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>with the pet regulations?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. Move-in inspection dated and signed by tenant and management?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9. Annual inspections documented in file?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### C. CERTIFICATION/RECERTIFICATION ACTIVITIES

<table>
<thead>
<tr>
<th>Question</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**All reported income and deductions verified and calculated correctly?**

<table>
<thead>
<tr>
<th>Income Type</th>
<th>Verified?</th>
<th>Reported on '59</th>
<th>Should have reported on '59</th>
</tr>
</thead>
<tbody>
<tr>
<td>3. Wages</td>
<td></td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>4. Social Security benefits</td>
<td>X</td>
<td>$ 12,312.00</td>
<td>$</td>
</tr>
<tr>
<td>5. Welfare/public assistance/TANF</td>
<td></td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>6. Other income</td>
<td>X</td>
<td>$ 3,000</td>
<td>$</td>
</tr>
<tr>
<td><strong>ASSETS: (Includes income from 7 or 8 below, whichever is greater)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. Actual income from assets</td>
<td></td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>8. Imputed income when assets</td>
<td>X</td>
<td>$ 701.00</td>
<td>$</td>
</tr>
<tr>
<td>greater than $5,000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>9. TOTAL ANNUAL INCOME (Total of</strong></td>
<td></td>
<td>$ 16,013.00</td>
<td>$</td>
</tr>
<tr>
<td><strong>Lines 3 through 6 plus applicable</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Line 7 or Line 8)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10. Dependent</td>
<td></td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>11. Medical</td>
<td>X</td>
<td>$ 1,720.00</td>
<td>$</td>
</tr>
<tr>
<td>12. Disability expenses</td>
<td></td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>13. Childcare</td>
<td></td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>14. Elderly/disabled household</td>
<td></td>
<td>$ 800.00</td>
<td>$</td>
</tr>
<tr>
<td><strong>15. TOTAL DEDUCTIONS (Total of</strong></td>
<td></td>
<td>$ 2,520.00</td>
<td>$</td>
</tr>
<tr>
<td><strong>Lines 10 through 14)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>16. TOTAL ADJUSTED INCOME (Line 9</strong></td>
<td></td>
<td>$ 13,493.00</td>
<td>$</td>
</tr>
<tr>
<td><strong>– Line 15)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**17. Is a HUD-approved Rent Schedule (HUD-92458) on file?**

<table>
<thead>
<tr>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

(If yes, list and compare the rental charges.)

<table>
<thead>
<tr>
<th>Rent Types</th>
<th>Rent Used</th>
<th>Form HUD-92458-Rent Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>18. Contract rent</td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>19. Gross rent</td>
<td>$ 450.00</td>
<td>$</td>
</tr>
<tr>
<td>20. Basic rent</td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>21. Market rent</td>
<td>$ 450.00</td>
<td>$</td>
</tr>
<tr>
<td>22. Was the correct unit rent used for rent determination?</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
Enter the amounts for the following:

<table>
<thead>
<tr>
<th>Description</th>
<th>Owner-calculated rent/assistance</th>
<th>Reviewer-calculated rent/assistance</th>
</tr>
</thead>
<tbody>
<tr>
<td>23. Total tenant payment</td>
<td>$337.00</td>
<td>$113.00</td>
</tr>
<tr>
<td>24. Tenant rent</td>
<td>$337.00</td>
<td>$</td>
</tr>
<tr>
<td>25. Utility reimbursement</td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>26. Assistance Payment</td>
<td>$113.00</td>
<td>$</td>
</tr>
</tbody>
</table>

27. Tenant paying minimum rent?  
   - Yes [X]  
   - No       
   - N/A      
28. Has a hardship exception been granted for paying minimum rent?  
   - Yes       
   - No [X]     
   - N/A      
29. If applicable, was utility reimbursement distributed within five business days of receiving the housing assistance payment?  
   - Yes       
   - No [X]     
   - N/A      
30. If applicable, was a 30-day notice provided to tenant to inform them of rent increase?  
   - Yes       
   - No [X]     
   - N/A      
31. If applicable, has tenant entered into a payment plan for monies due to the project?  
   - Yes       
   - No [X]     
   - N/A      

**D. BILLING**

<table>
<thead>
<tr>
<th>Description</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Does the assistance payment requested on the monthly billings (HUD-52670-A) agree with the assistance payment on the 59 data requirements printout?</td>
<td>[X]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. If required, have adjustments been made to the monthly billing?</td>
<td></td>
<td>[X]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**E. MOVE-OUT**

<table>
<thead>
<tr>
<th>Description</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Move-out notice from tenant?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Move-out inspection?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. If move-out inspection, is it dated?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. If move-out inspection, is it signed by the tenant and the owner/agent?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. Was the security deposit returned to tenant within 30 days?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. Was there an itemized list of the damages and charges?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. Were any additional charges paid by tenant?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. Was appropriate adjustment made on monthly billing (HUD-52670-A)?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**F. APPLICANT REJECTION**

<table>
<thead>
<tr>
<th>Description</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Was the reason applicant denied admittance in accordance with the tenant selection plan?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Did the rejection letter provide applicant the right to appeal?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. If the applicant appealed, was the appeal reviewed by someone other than the person who made the original decision?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Was the appeal processed and applicant notified of appeal decision within five days of the meeting?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Reviewer’s Income and Rent Worksheet for Elderly Case Study

Assets:

<table>
<thead>
<tr>
<th>Family Member</th>
<th>Type of Asset</th>
<th>Cash Value of Asset (market value less expenses)</th>
<th>Actual Income from Asset (market value x interest/dividend)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Totals:                                                                                   

Imputed income from assets (calculate if total cash value of assets is greater than $5,000):

Total cash value of assets x .02  ________________

Transfer the greater of Actual Income from Assets or Imputed Income from Assets to the appropriate Line 7 or Line 8 of the Sample Tenant File Worksheet.

Income:

<table>
<thead>
<tr>
<th>Family Member</th>
<th>Type of Income</th>
<th>Income Calculation</th>
<th>Total Income for Income Type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Total Income:  

Transfer the Total Income for each income type to the appropriate Lines 3 through 6 on the Sample Tenant File Worksheet.

Medical Expenses:

<table>
<thead>
<tr>
<th>Family Member</th>
<th>Type of Medical Expense</th>
<th>Medical Expense Calculation</th>
<th>Total Medical Expense for Each Type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Total Medical Expenses:  

NOTE: Be sure to deduct 3% of Total Annual Income (Line 9 of Sample Tenant File Worksheet) before transferring the medical expenses to Line 11 of the Sample Tenant File Worksheet.

3% of Total Annual Income  ______________________
May 15, 2003

Mr. Ted E. Baer, President
Pine Ridge Apartments, Inc.
1000 Wood Drive
Forest City, USA 12345

Dear Mr. Baer:

Subject: Project No: 084-EH089
        Contract No: WA04-T822-008
        Project Name: Pine Ridge Apartments
        Forest City, USA

On April 20, 2003, Ms. Daisy Smith of my staff conducted an on-site review of the subject project. The review of the project included the areas of Maintenance and Security, Financial Management, Leasing and Occupancy, Tenant/Management Relations, Drug-Free Housing Policy and General Management Practices. Details of the areas reviewed are in the enclosed Management Review Report. The results were discussed in the exit conference with Mr. Wolf.

Based on the areas reviewed, the report reflects an overall Satisfactory rating of your management operation. However, several deficiencies were noted, particularly in the areas of Leasing and Occupancy. These deficiencies, recommended corrective actions, and target completion dates are explained in the narrative section of the enclosed report.

Please review the enclosed report and provide us with a response by June 15, 2003. If you disagree with any of HUD’s determinations regarding compliance, the proposed corrective actions or target completion dates (TCD), response should explain why you disagree, provide evidence supporting your position and should propose revised corrective action(s) and target completion date(s). Ms. Smith is available to provide technical assistance to resolve the deficiencies noted in the attached report. If you need to discuss any of the report’s findings, recommendations, or target date completion dates prior to preparing your written response, feel free to contact Ms. Smith at 444-555-1213.

Sincerely,

John Doe
Supervisory Project Manager
USA Area Office

Enclosures
## Crosswalk Between Old Handbook and Revised Handbook

<table>
<thead>
<tr>
<th>Subject</th>
<th>Old Handbook 4350.3</th>
<th>Handbook 4350.3 Rev-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>Chapter 1</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>Eligibility for Assistance</td>
<td>Chapter 2, Section 1</td>
<td>Chapter 3, Section 1</td>
</tr>
<tr>
<td>Eligibility for Admission – Household</td>
<td>Chapter 2, Section 2</td>
<td>Chapter 3, Sections 1 and 2</td>
</tr>
<tr>
<td>Characteristics and Income</td>
<td>Chapter 3, Sections 1 and 2</td>
<td></td>
</tr>
<tr>
<td>Occupancy Standards</td>
<td>Chapter 2, Section 3</td>
<td>Chapter 3, Section 2</td>
</tr>
<tr>
<td>Marketing and Outreach</td>
<td>Chapter 2, Section 4</td>
<td>Chapter 4, Section 2</td>
</tr>
<tr>
<td>Taking Applications</td>
<td>Chapter 2, Section 5</td>
<td>Chapter 4, Section 3</td>
</tr>
<tr>
<td>Tenant Selection</td>
<td>Chapter 2, Section 6</td>
<td>Chapter 4, Sections 1, 3, and 4</td>
</tr>
<tr>
<td>Accessibility for Persons with Disabilities</td>
<td>Chapter 2, Section 7</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Determining Tenant Rents</td>
<td>Chapter 3, Section 1</td>
<td>Chapter 5, Section 4</td>
</tr>
<tr>
<td>Annual Income</td>
<td>Chapter 3, Section 2</td>
<td>Chapter 5, Section 1</td>
</tr>
<tr>
<td>Adjusted Income</td>
<td>Chapter 3, Section 3</td>
<td>Chapter 5, Section 2</td>
</tr>
<tr>
<td>Verification Requirements and Procedures</td>
<td>Chapter 3, Section 4</td>
<td>Chapter 5, Section 3</td>
</tr>
<tr>
<td>Leases and House Rules</td>
<td>Chapter 4, Section 1</td>
<td>Chapter 6, Section 1</td>
</tr>
<tr>
<td>Security Deposits</td>
<td>Chapter 4, Section 2</td>
<td>Chapter 6, Section 2</td>
</tr>
<tr>
<td>Charges in Addition to Rent</td>
<td>Chapter 4, Section 3</td>
<td>Chapter 6, Section 3</td>
</tr>
<tr>
<td>Unit Inspections</td>
<td>Chapter 4, Section 4</td>
<td>Chapter 6, Section 4</td>
</tr>
<tr>
<td>Termination of Tenancy</td>
<td>Chapter 4, Section 5</td>
<td>Chapter 8, Section 3</td>
</tr>
<tr>
<td>Recertifications/Terminations - General</td>
<td>Chapter 5, Section 1</td>
<td>Chapter 7, Introduction; Glossary</td>
</tr>
<tr>
<td>Annual Recertification Procedures</td>
<td>Chapter 5, Section 2</td>
<td>Chapter 7, Section 1</td>
</tr>
<tr>
<td>Interim Adjustments of Tenant Rent and/or</td>
<td>Chapter 5, Section 3</td>
<td>Chapter 7, Section 2</td>
</tr>
<tr>
<td>Assistance Payments</td>
<td>Chapter 5, Section 4</td>
<td>Chapter 8, Section 1</td>
</tr>
<tr>
<td>Removal of Subsidy</td>
<td>Chapter 5, Section 5</td>
<td>Chapter 8, Section 3</td>
</tr>
<tr>
<td>Fraud and Termination of Tenancy</td>
<td>Chapter 5, Section 5</td>
<td>Chapter 8, Section 3</td>
</tr>
<tr>
<td>Billing for Assistance Payments - General</td>
<td>Chapter 6, Section 1</td>
<td>Chapter 9, Sections 1 and 2</td>
</tr>
<tr>
<td>Definition of Forms and Guidance for Completion</td>
<td>Chapter 6, Section 2</td>
<td>Chapter 9, Sections 1 and 2</td>
</tr>
<tr>
<td>Section 8 Special Claims for Unpaid Rent,</td>
<td>Chapter 6, Section 3</td>
<td>Chapter 9, Section 2</td>
</tr>
<tr>
<td>Tenant Damages, and Other Charges</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Crosswalk Between Old Handbook and Revised Handbook

<table>
<thead>
<tr>
<th>Subject</th>
<th>Old Handbook 4350.3</th>
<th>Handbook 4350.3 Rev-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section 8 Vacancy Claims During Rent-up</td>
<td>Chapter 6, Section 4</td>
<td>Chapter 9, Section 2</td>
</tr>
<tr>
<td>Section 8 Special Claims for Vacancy Losses After Rent-up</td>
<td>Chapter 6, Section 5</td>
<td>Chapter 9, Section 2</td>
</tr>
<tr>
<td>Section 8 Special Claims – Debt Service Vacancy Payments</td>
<td>Chapter 6, Section 6</td>
<td>Chapter 9, Section 2</td>
</tr>
<tr>
<td>Monthly Report of Excess Income</td>
<td>Chapter 7, Section 1</td>
<td>Chapter 9, Section 2</td>
</tr>
<tr>
<td>Section 8 Occupancy Reporting Requirements</td>
<td>Chapter 7, Section 2</td>
<td>Chapter 9, Sections 1 and 2</td>
</tr>
</tbody>
</table>
How to use
HUD Handbook 4350.3
on CD
# Table of contents:

**Searching for Acrobat Reader on your computer**………………………………….p. 3

**Opening and Closing the Handbook**………………………………………………..p. 4

**Working with the Handbook**…………………………………………………………..p. 5

| A. Viewing | p. 5 |
| B. Moving | p. 7 |
| C. Searching | p. 7 |
| D. Copying to Another Application | p. 9 |
| E. Printing | p. 10 |
| F. Retracing your path | p. 12 |

**Browsing with Navigation Structure**………………………………………………..p. 12

| A. Browsing using bookmarks | p. 12 |
| B. Usage of bookmarks in the handbook | p. 13 |
| C. Browsing using links | p. 14 |
| D. Usage of links in the handbook | p. 15 |
| E. Browsing using thumbnails | p. 17 |
HUD Handbook 4350.3: Occupancy Requirements of Subsidized Multifamily Housing Programs has been converted to Acrobat format (PDF). Thus to view or print this handbook you must have Acrobat Reader installed on your computer. If you have Acrobat Reader already installed, the software will open the handbook when you click on its link. If you are not sure whether you have Acrobat Reader installed on your computer try steps in Section 1. (for Windows 95/98 users only):

(Go Back to Table of Contents)

1. Searching for Acrobat Reader on your computer:

   Click on the **Start** button on your computer, then highlight **Files or Folders** and click on **Find**.

   Enter "acrobat" as shown below in the "Named:" box. Then click on "Find Now".

   ![Find Acrobat Reader](image)

   If a list of files appears in a window underneath, then you most likely have Acrobat Reader installed on your computer.

   If nothing appears, then you most likely don't have Acrobat Reader. To download a FREE copy of Acrobat Reader click below.

   ![Get Acrobat Reader](image)

   or go to: [www.adobe.com/prodindex/acrobat/roadstep.html](http://www.adobe.com/prodindex/acrobat/roadstep.html)
To make navigation through the handbook quick and easy you need to know the basic operating functions of Acrobat Reader. If you are confident with Acrobat Reader, please go to Section 3 ‘Browsing with navigating structures’ where you will learn the logic behind bookmarks and links in this handbook.

2. Opening and Closing the Handbook:

Opening the Handbook:

1. Insert CD into CD-Rom Drive
2. Right mouse click on the Start button and open Windows Explore.  
3. Click on your CD-Rom Drive (often Drive D) 
4. Double click on Handbook 4350.3 icon to open the document

Note: Depending on the available recourses of your computer system, it may take a few seconds for Acrobat Reader to open the handbook. Please be patient.

Closing the Handbook:

Click File< Exit click or button on the Title Bar of Acrobat Reader.

(Go Back to Table of Contents)
3. Working with the Handbook

Examining the Toolbar

In this manual you will learn the tools associated with viewing, moving, searching for words, and capturing text and images within the handbook.

The picture below shows some of the most popular tools in Acrobat Reader. If you unable to view all or some of these buttons, please go to Windows > Toolbars and make sure that Basic, File, Navigation and Viewing toolbars have a check marks near them.

A. Viewing

*Acrobat Reader* allows you to customize the appearance of the page on the screen, so you can make adjustments for your own personal level of comfort when navigating though the handbook. You can change the magnification level of the handbook, set a page layout that determines whether you’ll see one page at a time or a continuous flow of pages and rotate the pages if needed. These all can be accomplished by pressing corresponding buttons on *Acrobat Reader* Toolbar.

Use the *magnifying glass* to increase or decrease page size
Zoom-in and zoom-out define the size of a page by a percentage. To change page size to preset values, click on the arrow located by the zoom box. Then choose desired magnification level.

Buttons actual size, fit in page, fit width of page used to adjust page size.

Use these buttons to rotate the page content from profile to landscape.

Ways to view pages: single page, continuous, and continuous-facing. These buttons are located on the Status bar at the bottom of the handbook (see picture above).
B. Moving

You can navigate in handbook by paging through them or by using navigational structures. You can also retrace your steps through the handbook to return to where you started. *Acrobat Reader* provides buttons, keyboard shortcuts, and menu commands for paging through the handbook. To move between pages use the scroll bars on the right side of the image or by using the following icons:

- First page, previous page, next page, and last page
- Click on *hand tool* to drag page up or down

To view a specific page use CTR+N shortcut to bring up ‘Go To Page’. Then type a logical page number of the desired page and click ‘OK’.

C. Searching:

You can use Find command to find a complete word or a part of a word in the handbook. *Acrobat Reader* looks for the word by reading every word on every page in the file, *beginning at the page that you are currently at and to the bottom of the handbook*.

Since HUD Handbook 4350.3 has a full-text index, it is more efficient to begin your search on the first page of the index rather than somewhere else in the handbook. Searching with an index is much faster than using the Find command, because when Acrobat looks for a word in the index it goes right to the word in the list rather than reading through the handbook.

i ) To find a word using the Find command:

1 Click the Find button , or choose Edit > Find, or CTR+F.

2 Enter the text to find in the text box.
3 Select search options if necessary:

- **Match Whole Word Only** finds only occurrences of the complete word you enter in the text box. For example, if you search for the word *stick*, the words *tick* and *sticky* will not be highlighted.

- **Match Case** finds only words that contain exactly the same capitalization you enter in the text box.

- By default Acrobat Reader performs search from the current page to the end of the handbook. Option **Find Backwards** allows starting the search from the current page and proceeding backward through the handbook.

4 Click on *Find*

Acrobat Reader finds the first occurrence of the word.

---

**ii) To find the next occurrence of the word:**

Do one of the following:

1. Choose *Edit > Find Again*, or **CTR+G**

2. Reopen the Find dialog box, and click Find Again. (The word must already be in the Find text box.).

**Note:** If you unable to see the results of ‘Find Again’, it is possible that Find Window is blocking the part of the handbook where that expression is located.

**How to move Find window:**

1. Position your cursor on the title bar of the Find Window (the blue bar at the top).
2. Click AND hold your left mouse

3. Drag the window to a ‘better’ place.

(DGo Back to Table of Contents)

D. Copying to another application:

You can select text or a graphic in the handbook, copy it to the Clipboard, and paste it into a document in another application such as a word processor. Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.

i) Select and copy text :

1 Select the text select tool $T^\text{select}$, and do one of the following:

• To select a line of a text, select the first letter of the sentence or phrase and drag to the last letter.
• To select multiple columns of text (horizontally), hold down Ctrl as you drag across the width of the handbook.
• To select a column of text (vertically), hold down $\text{Ctrl+Alt}$ as you drag the length of the handbook.
• To select all the text on the page, choose Edit > Select All. In Single Page mode, all the text on the current page is selected. In Continuous or Continuous - Facing mode, most of the text in the handbook is selected. When you release the mouse button, the selected text is highlighted. To deselect the text and start over, click anywhere outside the selected text.

The Select All command will not select all the text in the handbook.

2 Choose Edit > Copy to copy the selected text to the Clipboard.

3 Open a document that you are trying to create. Choose Edit > Paste.

ii) Copy graphics:

1 Select the graphics select tool $G^\text{select}$ . The cursor changes to the cross-hair icon.
2 Drag a rectangle around the graphic you want to copy. To deselect the graphic and start over, click anywhere outside the selected graphic.

3 Choose Edit > Copy to copy the graphic to the Clipboard.

4 Open a document that you are trying to create. Position the cursor to a place where you want the graphic to be displayed. Then Choose Edit > Paste.

(Go Back to Table of Contents)

E. Printing and Downloading

You can print the entire handbook; specify a range of pages, noncontiguous pages, or a particular page to print before opening the dialog box.

To print the handbook:

1. If you don’t need to print the entire handbook, do one of the following:
   • To select pages to print, click thumbnails in the Thumbnails palette. You can Ctrl-click thumbnails to select non-contiguous pages, or Shift-click to select a contiguous range of pages. You can also select a contiguous page range in the Print dialog box.
   • To select an area on a page to print, select the graphic select tool  , and drag on the page to draw the area you want.


   • Click the Print button  , or choose File > Print.
   • Specify the printer, page range, number of copies, and other options
   • Click OK
• Page From/To prints a range of pages. To print specific pages you must use Logical Page Numbers.

To find Logical Page Numbers, refer to the first number displayed on the pagination indicator (see picture on page 13), located on the Status bar of the Acrobat Reader.

For example, to print page of the handbook numbered “i”, logical page number 5, you should select the third radio button on Print Rage frame, then enter Pages ‘5’ to ‘5’ print that page. (see picture above).

• Auto-rotate and center pages adjusts the handbook’s orientation to match that specified in the printer properties. It is imperative to select this option when printing Appendix 3.

Warning: If by mistake you have selected “All 876 pages”, go to the printer and use printer’s Cancel button to abort the action.

(Go Back to Table of Contents)
F. Retracing your viewing path

After you have paged through the handbook or used navigational structures to move through the handbook, you can retrace your path back to where you started.

_Do one or more of the following:

• To retrace your path within the handbook, click the _Go To Previous View_ button in the navigation toolbar (located at the top of the page), or choose Document > Previous Page for each step back. Or click the _Go To Next View_ button, or choose Document > Next Page for each step forward._

(Go Back to Table of Contents)

4. Browsing with navigational structures

_Acrobat Reader_ offers a wide range of navigational structures to help you move to specific places in the Handbook:

- **Bookmarks** provide a visual layout of the handbook.

- **Links** are used to quickly locate a specific location of the handbook or related Web sites. In this handbook a blue font identifies links.

- **Thumbnails** provide miniature previews of handbook pages. You can use thumbnails to move pages, to change the display of pages, and to go to other pages. A page-view box in a thumbnail indicates the area of the page currently showing in the handbook pane. You can view many pages at a time by opening Thumbnails pane.

A. Browsing using bookmarks:

Some users may prefer to have a larger reading area to facilitate reading from the screen. This can be accomplished by hiding the Bookmarks palette through the following steps.
1. Choose Window > Bookmarks, or press key **F5**.
2. To jump to a topic using its bookmark, click the bookmark’s icon or text in the palette.
3. To reverse your action, repeat step #1.

(Go Back to Table of Contents)

**B. Usage of Bookmarks in the Handbook:**

Bookmarks are subordinate to other bookmarks in their hierarchy; a higher-level bookmark in this relationship is the parent, and a lower level bookmark is the child. When you open handbook for the first time, you will see only a few bookmarks that represent the highest level of handbook’s schema. Each of these bookmarks (except Transmittal and Cover) has 2-4 subordinate levels of other bookmarks covering topics in greater details. All bookmarks have a visual clue that identifies their level (plus, minus or blank). When a parent bookmark is collapsed (see picture below), it has a plus sign next to it. If the bookmark you want to click is hidden in a collapsed parent, click the plus sign next to the parent to show it.

**Bookmark Table of Contents** is one of the highest levels of bookmarks. It has two additional secondary levels of bookmarks: Chapters, Exhibits and Appendices, where each lists titles to every chapter, every exhibit and every appendix in the handbook. Subordinate bookmarks for Appendices are subjectively grouped into three parts to decrease amount of scrolling you have to do.

Bookmarks for **Chapters 1-9** contain a detailed outline of the handbook. Each of the chapters (except Chapter 1) has four subordinate levels of other bookmarks representing sections, paragraphs and subparagraphs of the text.

**Bookmark Glossary** has two secondary levels of bookmarks: the first one looks like an alphabet and allows you quickly access the definitions of the expressions that start with a specific letter, last subordinate level contains **only** definitions that begin with a specific letter and targeted for users who want to look up a definitions of a specific expression.

**Bookmark Appendix** has 1-2 additional secondary levels of bookmarks and provides a quick access to a specific appendix of the handbook.

**Bookmark Index** has only 1 additional secondary level of bookmarks where each bookmarks stands for a first letter of expressions used throughout the handbook. When you click on a specific letter of the **Index**, Acrobat Reader will display the first page of the **Index** where expressions that begin with that letter are listed. Please scroll down to find a target expression.
C. Browsing using links:
1. Position the pointer over blue text area on the page until pointer changes to the hand with a pointing finger.
   (The hand has a W sign in it if the links point to the Web.)
2. Then click the link.
D. Usage of Links in the Handbook:

The body of Table of Contents consists primarily of links that will assist users who are already fairly familiar with the contents of the handbook and are looking for a quick way to get to the beginning of a specific chapter, section or paragraph in the handbook. Links in Chapters, Exhibits, Appendices, Glossary and Index are used to provide an expedient placement of the referenced topic in the handbook or the Web. By clicking on the link user will be transferred to the beginning of that reference. Besides links that lead to a specific place in the Chapters, Appendices, Glossary or Exhibits, Index has links that point to another place within Index itself. These are the links that begin with “see also…….”

Note: Throughout the handbook you will encounter reference to other HUD’s handbooks. Titles of handbooks marked by blue font, for example HUD Handbook 4350.1, Multifamily Asset Management and Project Servicing, are links to pages of www.hadelips.org database where that book is published as of June 2003. To access that handbook in ‘one click’ you have to be connected to the Internet. After clicking on the title you may see a warning sign (see picture below). Click ‘Yes’.

If you are opening Handbook 4350.1, for example, the page that your default browser will open in a new window should looks like the picture below.
To open handbook 4350.1, first click on expanded link. Then proceed to the intended destination.

(Use Expanded link to view the contents of the handbook)

Housing Handbooks:

<table>
<thead>
<tr>
<th>REF</th>
<th>DOCN</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4350.1</td>
<td><strong>Multifamily Asset Management and Project Servicing</strong></td>
</tr>
</tbody>
</table>

To open handbook 4350.1, first click on **Expanded** Link. Then proceed to the intended destination.

(Use Expanded link to view the contents of the handbook)
E. Browsing using thumbnails:

1 Show the Thumbnails palette. You may need to choose Window > Show Thumbnails to open the palette or click the Thumbnails tab to bring the palette to the front of its group.

2 Do one of the following:
   • To jump to another page, click the page’s thumbnail.
   • To display another part of the current page, position the pointer over the edge of the page-view box in the page’s thumbnail until the pointer changes to the hand tool. Then drag the box to move the view area.
Sample Tenant File Review Worksheet

**Instructions:** Review the appropriate number of tenant files and complete this worksheet for each file reviewed. Indicate the initial move-in date in the appropriate box and, if applicable, indicate the current recertification year. Indicate each document available in the tenant file by marking the appropriate corresponding box (Yes, No, or N/A).

<table>
<thead>
<tr>
<th>Date:</th>
<th>Reviewed by:</th>
</tr>
</thead>
</table>

**Type of Review:**
- Applicant Rejection □
- Tenant Move-In □
- Tenant Move-Out □
- Certification/Recertification □

**If Certification/Recertification, indicate certification type:**
- Certification type: Initial □
- Annual □
- Interim □
- N/A □

**Project Name:**

**Type of Housing:**
- Elderly □
- Family □
- Disabled □

**Project No.:**

**Contract No.:**

**Type of Subsidy:**
- Section 8 □
- PRAC □
- Section 236 □
- PAC □
- 221(d)(3) BMIR □
- Rental Supplement □

**Family Name:**

**Unit Number:**

**Bedroom Size:**
- 0 Bedrooms □
- 1 Bedroom □
- 2 Bedrooms □
- 3 Bedrooms □
- 4 Bedrooms □
- 5 or more Bedrooms □

**Effective date of certification(s) reviewed:**

### A. HOUSEHOLD INFORMATION

<table>
<thead>
<tr>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Application complete and stamped by owner for date and time received?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>2. Household members identified correctly? (head, spouse, dependent, live-in aide)</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>3. Unit size appropriate for household?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>4. Was household income eligible at move-in?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Over income □ Low income □ Very low income □ Extremely low income □</td>
</tr>
<tr>
<td>5. If household was not income eligible at move-in, was an exception granted?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>6. Resident Rights and Responsibilities acknowledgement?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>7. Ethnicity and racial data certification?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>8. HUD-9887/9887-A Consent forms signed by head, spouse, co-head regardless of age and family members at least 18 years of age?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>9. Lead-based paint acknowledgement, if applicable?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>Have the following items been properly verified and documented?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>10. Social Security numbers for all family members or certification if no SSN?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>11. Declaration of citizenship or eligible immigrant status?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>12. Criminal and drug screening; sex offender registration?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>13. Other screening as disclosed in tenant selection plan?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>14. Disability, if applicable?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>15. Student status, if applicable?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>16. Age, if applicable?</td>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
</tbody>
</table>
## B. LEASE

<table>
<thead>
<tr>
<th></th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Correct HUD model lease used?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td></td>
</tr>
<tr>
<td>2. Original lease and subsequent leases or addendums signed by management, head, spouse, co-head, and all other adult members of the household?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td></td>
</tr>
<tr>
<td>4. Are applicable attachments attached to the lease, (e.g., house rules, pet rules, unit inspection report)?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td></td>
</tr>
<tr>
<td>5. If security deposit is required, was it correct?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td></td>
</tr>
<tr>
<td>If required, enter amount here:</td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. If pet deposit is required, was it correct?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td></td>
</tr>
<tr>
<td>If required, enter amount here:</td>
<td>$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. If pet deposit was paid in installments was payment in accordance with the pet regulations?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td></td>
</tr>
<tr>
<td>8. Move-in inspection dated and signed by tenant and management?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td></td>
</tr>
<tr>
<td>9. Annual inspections documented in file?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td></td>
</tr>
</tbody>
</table>

## C. CERTIFICATION/RECERTIFICATION ACTIVITIES

<table>
<thead>
<tr>
<th></th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Certification notices given?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td></td>
</tr>
<tr>
<td>2. Certifications completed on time?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td></td>
</tr>
</tbody>
</table>

### All reported income and deductions verified and calculated correctly?

<table>
<thead>
<tr>
<th>Verified?</th>
<th>Reported on '59</th>
<th>Should have reported on '59</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>No</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

### ASSETS: (Includes income from 7 or 8 below, whichever is greater)

<table>
<thead>
<tr>
<th></th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>7. Actual income from assets</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>$</td>
</tr>
<tr>
<td>8. Imputed income when assets greater than $5,000</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>$</td>
</tr>
<tr>
<td>9. TOTAL ANNUAL INCOME (Total of Lines 3 through 6 plus applicable Line 7 or Line 8)</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>$</td>
</tr>
<tr>
<td>10. Dependent</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>$</td>
</tr>
<tr>
<td>11. Medical</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>$</td>
</tr>
<tr>
<td>12. Disability expenses</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>$</td>
</tr>
<tr>
<td>13. Childcare</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>$</td>
</tr>
<tr>
<td>14. Elderly/disabled household</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>$</td>
</tr>
<tr>
<td>15. TOTAL DEDUCTIONS (Total of Lines 10 through 14)</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>$</td>
</tr>
<tr>
<td>16. TOTAL ADJUSTED INCOME (Line 9 – Line 15)</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>$</td>
</tr>
<tr>
<td>17. Is a HUD-approved Rent Schedule (HUD-92458) on file?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>Yes</td>
</tr>
</tbody>
</table>

(If yes, list and compare the rental charges.)

### Rent Types

<table>
<thead>
<tr>
<th>Rent Types</th>
<th>Rent Used</th>
<th>Form HUD-92458-Rent Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>18. Contract rent</td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>19. Gross rent</td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>20. Basic rent</td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td>21. Market rent</td>
<td>$</td>
<td>$</td>
</tr>
</tbody>
</table>

### 22. Was the correct unit rent used for rent determination? | Yes | No | ☐ | ☐ |
<table>
<thead>
<tr>
<th>Enter the amounts for the following:</th>
<th>Owner-calculated rent/assistance</th>
<th>Reviewer-calculated rent/assistance</th>
</tr>
</thead>
<tbody>
<tr>
<td>23. Total tenant payment:</td>
<td>$</td>
<td></td>
</tr>
<tr>
<td>24. Tenant rent:</td>
<td>$</td>
<td></td>
</tr>
<tr>
<td>25. Utility reimbursement:</td>
<td>$</td>
<td></td>
</tr>
<tr>
<td>26. Assistance Payment:</td>
<td>$</td>
<td></td>
</tr>
</tbody>
</table>

| 27. Tenant paying minimum rent?     | Yes    | No    | N/A   | Comments: |
| 28. Has a hardship exception been granted for paying minimum rent? | Yes    | No    | N/A   | Comments: |
| 29. If applicable, was utility reimbursement distributed within five business days of receiving the housing assistance payment? | Yes    | No    | N/A   | Comments: |
| 30. If applicable, was a 30-day notice provided to tenant to inform them of rent increase? | Yes    | No    | N/A   | Comments: |
| 31. If applicable, has tenant entered into a payment plan for monies due to the project? | Yes    | No    | N/A   | Comments: |

<table>
<thead>
<tr>
<th>D. BILLING</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Does the assistance payment requested on the monthly billings (HUD-52670-A) agree with the assistance payment on the 59 data requirements printout?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
<tr>
<td>2. If required, have adjustments been made to the monthly billing?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E. MOVE-OUT</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Move-out notice from tenant?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
<tr>
<td>2. Move-out inspection?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
<tr>
<td>3. If move-out inspection, is it dated?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
<tr>
<td>4. If move-out inspection, is it signed by the tenant and the owner/agent?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
<tr>
<td>5. Was the security deposit returned to tenant within 30 days?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
<tr>
<td>6. Was there an itemized list of the damages and charges?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
<tr>
<td>7. Were any additional charges paid by tenant?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
<tr>
<td>8. Was appropriate adjustment made on monthly billing (HUD-52670-A)?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>F. APPLICANT REJECTION</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
<th>Comments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Was the reason applicant denied admittance in accordance with the tenant selection plan?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
<tr>
<td>2. Did the rejection letter provide applicant the right to appeal?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
<tr>
<td>3. If the applicant appealed, was the appeal reviewed by someone other than the person who made the original decision?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
<tr>
<td>4. Was the appeal processed and applicant notified of appeal decision within five days of the meeting?</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
<td>Comments:</td>
</tr>
</tbody>
</table>